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About This Manual 

Related Documentation 

• Indexer 2 Program User Guide 

• ASCII Interface Programmer’s Guide  

• Camming User Guide 

• CANOpen Programmers Guide 

• Parameter Dictionary 

• Serial Encoder Guide 

 

Copley Controls software and related information can be found at: 

https://www.copleycontrols.com/en/support/ 

Copyrights 

No part of this document may be reproduced in any form or by any means, electronic or 

mechanical, including photocopying, without express written permission of Copley Controls. 

 

CME, Copley Virtual Machine, CVM, Xenus, Accelnet, Stepnet, Accelus, and Junus are registered 

trademarks of Copley Controls. 

 

Windows 7, Windows 8, and Windows 10 are registered trademarks of the Microsoft Corporation. 

 

Document Validity  

We reserve the right to modify our products. The information in this document is subject to 

change without notice and does not represent a commitment by Copley Controls. Copley Controls 

assumes no responsibility for any errors that may appear in this document.  

https://www.copleycontrols.com/en/support/
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Product Warnings 

Observe all relevant state, regional and local safety regulations when installing and using Copley 

Controls amplifiers. For safety and to assure compliance with documented system data, only 

Copley Controls should perform repairs to amplifiers. 

 
DANGER 

Hazardous voltages. 

Exercise caution when installing and adjusting Copley amplifiers. 

Risk of electric shock. 

On some Copley Controls amplifiers, high-voltage circuits are 

connected to mains power. Refer to hardware documentation. 

Risk of unexpected motion with non-latched faults. 

After the cause of a non-latched fault is corrected, the amplifier re-

enables the PWM output stage without operator intervention. In this 

case, motion may re-start unexpectedly. Configure faults as latched 

unless a specific situation calls for non-latched behavior. When using 

non-latched faults, be sure to safeguard against unexpected motion. 

Latching an output does not eliminate the risk of unexpected 

motion with non-latched faults. 

Associating a fault with a latched, custom-configured output does 

not latch the fault itself. After the cause of a non-latched fault is 

corrected, the amplifier re-enables without operator intervention. In 

this case, motion may re-start unexpectedly.  

For more information, See Error! Reference source not found.. 

When operating the amplifier as a CAN or EtherCAT node, the use of 

CME or ASCII serial commands may affect operations in progress. 

Using such commands to initiate motion may cause network 

operations to suspend.  

Operation may restart unexpectedly when the commanded motion is 

stopped. 

Use equipment as described. 

Operate amplifiers within the specifications provided in the relevant 

hardware manual or data sheet.  Do not attempt to modify, repair, 

or change any component of the amplifier or drive, doing so may 

void any warranties. 

 

FAILURE TO HEED THESE WARNINGS CAN CAUSE EQUIPMENT 

DAMAGE, INJURY, OR DEATH. 

!
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 INTRODUCTION  

1.1: Host Computer Requirements 

Computer and Operating System 

Minimum hardware requirements: 

• CPU: 2 GHz  

• RAM: 2 GB  

Operating Systems Supported: Windows 7 (64-bit only), Windows 8 and Windows 10. 
For users running 32-bit machines, version 7.2 can still be used.  Use the following link 
to download version 7.2. 

Default File Locations 

The default location for CME data files (ccx, ccm, etc.) is  

C:\Users\Public\Public Documents\Copley Motion\CME 

Serial Communications Requirements 

• Standard RS-232 serial port or a USB-to-RS-232 adapter. 

• Serial communication cable. See data sheet for part numbers. 

CAN Communications Requirements (With Copley CANopen Drives) 

• CAN card.  The following CAN card manufacturers are supported: 

• Copley Controls CAN PCI card (CAN-PCI-02, CAN-PCIe-01, CAN-PCIe-02, CAN-USB-01, 

CAN-PC104-02) 

• Kvaser 

• CANopen network cable (see data sheet for part number and wiring instructions). 

EtherCAT Communications Requirements (With Copley EtherCAT Drives) 

• Ethernet adapter dedicated to the EtherCAT network. 

• EtherCAT network cable, (see data sheet for wiring instructions). 

 

1.2: Overview 

Setup and Tuning 

Java based CME configuration software is powerful and intuitive.  Comprehensive diagnostics, 

auto-tuning and advanced oscilloscope tools simplify system commissioning.  Auto-phasing 

eliminates time consuming rewire-and-try for encoder/Halls/motor connections. CME 

automatically compensates for crossed wires eliminating the most common cause of startup 

headaches. 

Indexing 

Point-and-click to define up to 32 indexes or index sequences.  Simply select the index/sequence 

and command GO. Index sequences can include motion, parameter changes, dwell times and 

I/O control. Any parameter can be assigned to a register for efficient control by a PLC. 

 

Custom functions can be provided for complex applications.  Install the Java "bean" and fill in 

the blanks. Copley also provides a flexible OEM programming environment. Copley Virtual 

Machine assembler/debugger enables the development of fast, compact control program. 

Cam Tables 

Camming is an effective way to produce repetitive motion synchronized to an external device. 

A pre-defined cam-table of slave positions is typically cycled through by a master encoder 
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connected to the drive. The drive performs linear interpolation between points to minimize cam-

table size. 

 

NOTE: The feature descriptions in this manual may not apply to all Copley Controls amplifiers 

under all configurations. Significant differences between amplifier models are noted. See the 

relevant hardware manual or data sheet for more information. 

 

Gain Scheduling 

Frequency Analysis 

Plus feature 

FPGA Firmware 

ARM firmware 

 

1.3: Servo Operating Modes and Control Loops 
Servo Operating Modes and Control Loops 

Copley Controls drives use up to three nested control loops - current, velocity, and position - to 

control a motor in three associated operating modes. (Stepper drives operated in stepper mode, 

function as traditional open position loop stepper drives). 

Control Loops Model 

In position mode, the amplifier uses all three loops. As shown in the typical system illustrated 

below, the position loop drives the nested velocity loop, which drives the nested current loop.  

 

 
 

In velocity mode, the velocity loop drives the current loop. In current mode, the current loop is 

driven directly by external or internal current commands. 

 

 

 

 

 

 

 

 

 

  

Target

Position

Position

Command

Actual CurrentDerived VelocityActual Position

Velocity

Command

Current

Command

Limited

Velocity

Limited

Current

PWM

Command

Trajectory

Generator

Position

Loop

Velocity

Limiter

Current

Limiter

Current

Loop

Motor/

Sensors

Limits

Velocity

Loop

F
ILT

E
R

F
ILT

E
R



Introduction  

12 Copley Controls 

Basic Attributes of All Servo Control Loops 

 

Loop 

Attribute 

Description 

Command 
input 

Every loop is given a value to which it will attempt to control. For example, the 
velocity loop receives a velocity command that is the desired motor speed. 

Limits Limits are set on each loop to protect the motor and/or mechanical system. 

Feedback The nature of servo control loops is that they receive feedback from the device 

they are controlling. For example, the position loop uses the actual motor 
position as feedback. 

Gains These are constant values that are used in the mathematical equation of the 

servo loop. The values of these gains can be adjusted during amplifier setup to 
improve the loop performance. Adjusting these values is often referred to as 
tuning the loop. 

Output The loop generates a control signal. This signal can be used as the command 

signal to another control loop or the input to a power amplifier. 

 

For more information on using CME to set up and tune control loops, see Control Loops. 
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 INSTALLATION, STARTUP, AND INTERFACE TOUR  

This section provides information on how to download and install the CME software.  

This section also provides a guide on the initial startup of CME, as well as a tour of the 

UI. 

 

2.1: Download and Install CME Software 
 

1. Go to www.copleycontrols.com. 

2. Navigate to General Resources under Support. 

3. Click on Software. 

4. Navigate to CME Software Ver 8.0. 

5. Click on download icon . 

6. Add the email address to register. The link to download the software will be sent to the 

email address. 

7. Click on the link and download the software. 

8. Extract the contents of CME.zip.  

9. Run Setup.exe and follow the instructions on the installer screens.   

 

Note: It is recommended that all default installation values are accepted.  

 

 

2.2: Special Notes for Windows 7, Windows 8 and Windows 10 
 

Installer 

When the installer starts, Windows will display a dialog asking for permission to make changes 

to your computer.  Click the button to allow the installer to continue, and CME will be installed. 

Set up CME to run as administrator 

On some versions of Windows 7, Windows 8 and Windows 10, CME will have to be set up to run 

as administrator to access the communications drivers (Serial, CANopen, EtherCAT).   

 

1. Right-click the CME icon  on the desktop. 

2. Choose Properties from the pop-up menu. 

                                                                           

 

3.  

http://www.copleycontrols.com/
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4. Click the Advanced button on the Properties dialog. 

                          

Note: The name of the application has been changed from CME2 to CME, but the 

files will be downloaded to a “CME2” folder. 

 

5. Select Run as Administrator.  Click OK to close the Advanced Properties dialog, 

then OK to close the Properties dialog. 
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2.3: Start CME   

1. Double-click the CME shortcut icon  on the Windows desktop to start CME. 

 If communications were set up already, the CME Main Screen opens.  

If there are multiple ports, Copley Neighborhood will be selected in the tree as shown below: 

                     

        Select the desired drive. For instance: 

                                         

If communications were not set up, the Communications Wizard will be displayed as shown 

below: 

 

                  

In this case, proceed to Communications Wizard. 
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            Example of a CME Main Screen after an amplifier has been selected. 

 

2.4: Communications Wizard 

Configure Serial Ports 

 

1. Start the Communications Wizard. 

If communications have never been set up, the Communications Wizard will be displayed 

automatically when CME starts up.   

If communications have already been set up, choose Tools→Communications Wizard. 

Choose Serial Ports and click Next. 

 

       

 

2. Select Serial Ports. 

Select one or more serial ports from the Available Ports list. 

Click Add. 
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    When all the desired ports have been added, click Next. 

 

3. Configure serial ports. 

 

• Select a port from the Selected Ports list. 

• Choose a Baud Rate for that port. 

• Repeat for each selected port. 

 

             
 

• Click Finish to save the settings. 
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Configure CANopen Network 

 

1. Start the Communications Wizard. 

If communications have never been set up, the Communications Wizard will be displayed 

automatically when CME starts up.   

If communications have already been set up, choose Tools→Communications Wizard. 

      Choose CAN Network and click Next. 

         

 

 

2. Configure CANopen Network 

1. Select the CAN Card from the list. 

2. Enter the channel number (0 for single channel CAN cards) in Channel. 

3. Select the Bit Rate (1Mbit/s Drive default) 

        

4. Click Finish to save the settings.  

Notes:  

1. The CAN Card list only shows the CAN cards that are supported by CME and are 

properly installed on the PC. 

2. LSS can be used if all nodes are 0 and no switch is being used. 
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Configure EtherCAT Network 

 

1. Start the Communications Wizard. 

If communications have never been set up, the Communications Wizard will be displayed 

automatically when CME starts up.   
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If communications have already been set up, choose Tools→Communications Wizard.  

Choose EtherCAT and click Next. 

 

    

 

2. Select the appropriate Network Adapter. 

 

 

3. Click Finish to save the settings. 
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2.5: Connect to an Amplifier 
 

Choose an amplifier by clicking on its name in the Copley Neighborhood. When there is only one 

amplifier, CME will automatically connect on startup. 

 

 

Serial port 

 

CAN network 

 

 

 

 

 

 

 

 

 

 

 

 

EtherCAT network  

(Multi Axis B) 
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2.6: Rename an Amplifier 

1. Navigate to Node. 

2. Choose Main Menu Amplifier→Rename to open the Rename Amplifier screen. 

 
 

 

3. Enter the new name and click OK to close the screen. The Drive name is now in FLASH 

and can be seen in the tree. 
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2.7: CME Interface Tour 
 

CME features are called out in the diagram below. Screen details vary depending on amplifier  

 

 

    

         

Copley 
Neighborhood Tree 

Axis Selection 

Status Bar 

Main Menu 

      Toolbar 

Functional 
Diagram 
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    Tool Bar 

 

Icon Name For More Information 

   
Setup Error! Reference source not 

found. for initial setup 

   
Control Panel Control Panel                                                                                                        

   
Auto Phase Motor Phasing 

   
Scope Oscilloscope                                                                                                                                                                                                                              

   
Frequency Analysis Frequency Analysis 

   
Error Log Error Log                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                         

   
Amplifier Properties                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                    

   
Save to disk 

Data Management Tools 
   

Restore from disk 

   
Save to flash 

   
Restore from flash 

Menu Bar 

 

 File Menu 
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Type Option Description For More Information 

 

.ccd 

Save Drive 

Configuration  

Saves the entire contents of 

amplifier flash to a drive 
configuration file. This includes all 

CVM programs, gain schedules and 
all file types in flash. 

 

Data, Firmware, and 

Logs 

 

.ccx 

 

Save Amplifier Data  

Saves contents of amplifier RAM to 

a file on disk. 

 

.ccx 

 

Save As→Single Axis 

For multi-axis drives only: saves 
one axis to a file on disk. (Available 
only for older drives) 

.ccx Save As→V4.1 Format Saves amplifier data file in format 
usable by CME 2 Version 4.1. 
(Available only for older drives) 

  

Copy Axis 

For multi-axis drives only: copies 
the setting from one axis to 

another. 

 

.ccd 

Restore→Drive 
Configuration  

Restores contents of a drive 
configuration file to amplifier’s 
flash. This includes all file types in 
flash. 

 

.ccd 

 

Save MACRO File 

(MACRO amplifiers only) Saves 
amplifier setup and tuning 
parameters in a format that can be 

read by Delta Tau controllers. 

 

.ccx 

Restore→Amplifier 
Data  

Restores contents of an amplifier 
file from disk to amplifier RAM. 

 

.ccx 

Restore→Single Axis For multi axis drives only:  restores 
contents of an amplifier file to only 
one axis 

 

.ccp 

Restore→CVM Control 
Program  

Restores a CVM program from a file 
to the CVM Flash.  

 

.cce 

Restore→CVM 
Encoder Correction 
Table  

Restores a correction table from 

disk to the CVM flash. 

 

 

.cct 

Restore→Cam Tables Restores a Cam Table file (.cct).   

 

.ccg 

Restore→Gain 
Scheduling Table 

Restores Gain Scheduling Table 

from a file (.ccg).  

Gain Scheduling 

Exit  Closes CME 2.   
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Amplifier Menu 

      

                
 

Option Description  For more information  

Setup Opens Setup screen SetupError! Reference 

source not found. 

Control Panel Opens Control Panel Control Panel 

Auto Phase Opens Auto Phase tool Motor Phasing 

Scope Opens Scope Tool screen Scope 

Frequency 

Analysis 

Opens Frequency Analysis 

tool 

Frequency Analysis 

Error Log Opens Error Log screen Error Log 

Amplifier 

Properties 

Displays basic amplifier 

properties 

 

Network 

Configuration 

Opens the Network 

Configuration screen 

Network Configuration 

Rename Prompts for new amplifier 
name 

Rename an Amplifier 

Gain Scheduling Opens Gain Scheduling 
screen 

Gain Scheduling 
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       Tools Menu 

                 
 

 

 

             

  

Selection Description For More Information 

Communications 

Wizard 

Starts sequence of prompts 

to set up communications 

Communications Wizard 

Communications 
Log 

Opens Communications 
Log 

Communications Log 

Download 
Firmware & FPGA 
Program 

Starts prompts to download 
firmware from disk to 
amplifier 

Firmware Download 

Manual Phase Opens Manual Phase tool Manual Phase 

View Scope Files Opens Trace Viewer 

window 

Scope Trace Files 

CME Lock/Unlock Opens screen for locking 

and unlocking CME 
functionality 

Lock/Unlock CME 

ASCII Command 

Line 

Opens screen to accept 

ASCII format commands 

Copley ASCII Interface 

Login Opens Login screen which 
prompts to enter 

credentials for a local 
installation 

 

I/O Line States Opens I/O Line States 
window, showing high/low 

status of the amplifier’s 
inputs and outputs 
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 Help Menu 

Selection Description 

CME User Guide Opens this manual 

All Documents Opens the Doc folder in the CME installation 
folder  
(typically c://Program Files/Copley Motion/CME 

/Doc). 
This folder contains all the related documents 
that were installed with CME. 

Copley Controls 

Website  

Opens default web browser with pages from 

Copley Controls’ website 

View Release 

Notes 

Opens latest CME release notes in a text viewer 

About Displays CME version information 

 

Functional Diagram 

The functional diagram, shown below, provides button-click access to most of the screens 

used to configure an amplifier. It also indicates the flow of control from input, across all 

active control loops, to motor/feedback. Only those control loop buttons that are 

appropriate to the amplifier and operational mode appear on the diagram. 
 

 
 

Button Description For More Information 

Input/ 

Output 

Opens Input/ Output screen Digital Inputs and Outputs 

CVM Control 
Program 

Opens Copley Virtual Machine screen Copley Indexer Program User’s 
Guide. 

Input 

Command 

Opens screen for configuring the input 

command 
Button text varies depending on the selected 
control loop input 

Command Inputs 

Control 

Loops 

Each opens a control loop configuration 

screen 

Control Loops 
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Motor Opens the Motor/Feedback screen   

Home Configure and test homing Homing 

Configure 

Regen 

Opens Regen Settings screen Regen Resistor Configuration 

Configure 

Faults 

Opens Fault Configuration screen Error! Reference source not 

found. 

Configure 

Filters 

Opens Filter Configuration screen Filters 

Encoder 
Correction 

(Stepper amplifier with encoder only) Opens 
Encoder Correction screen 

Encoder Correction 

Detent (Stepper amplifier only) Opens stepper 
amplifier Advanced Tuning screen 

Detent Compensation Gain 

Position 

Limits 

(Stepper amplifier with encoder only) Opens 

Position Limits screen 

Position Limits (Stepper 

Amplifier) 

 

CAN Information and Status Bar 

 

CAN Information 

The Main screen displays the basic CAN information.  

The example below shows CAN information: 

   
 

The Address field shows the amplifier’s present CAN address. For more information, see Network 

Configuration. When the Position Loop Input is set to CAN, the State field shows the state of the 

amplifier’s CANopen state machine (for more information, see Copley Control’s CANopen 

Programmer’s Manual). 

 

Status Bar 

The status bar describes the amplifier control status as shown below. It also includes a reminder 

that pressing the F12 function key while CME is running disables the amplifier.  
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 AMPLIFIER SETUP  

3.1:  Setup Procedure  

Warnings and Notes 

 

NOTE: To software disable the amplifier at any time while running CME, press function key F12. 

Also, the amplifier’s enable input can be used to disable the amplifier.  

 

DANGER 

DANGER: Hazardous voltages. 

Exercise caution when installing and adjusting. 

Do not make connections to motor or drive with power 

applied. 

Risk of unexpected or uncontrolled motion with CME in 

CAN mode. 

CME can be used while the amplifier is under CAN or EtherCAT 

control. However, some extreme changes made with CME  

could cause unexpected or uncontrolled motion. 

Failure to heed these warnings can cause equipment 

damage, injury, or death. 

 
WARNING 

Spinning motor with power off may damage amplifier. 

Do not spin motors with power off. Voltages generated by a 

motor can damage an amplifier. 

Failure to heed this warning can cause equipment 

damage. 

  

!

!
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1. Prepare for setup. 

a. Understand the procedure’s Warnings and Notes. 

b. Verify that the amplifier power is OFF. 

c. Verify wiring and connections. 

d. Make sure motor is securely fastened with no load connected. 

e. Apply power to the amplifier. For off-line amplifiers apply 24V only. 

For DC amplifiers apply AUX HV only. 

 

2. Start CME and enter Setup parameters. 

a. Double-click the CME icon  on the desktop to start CME. 

If necessary, connect to an amplifier from the list in the Copley Neighborhood     

tree.  

b. If the Setup screen does not appear, click the Setup button . 

c. Choose: 

In most cases, click Change Settings to Change Setup 

Settings. Then proceed to Step 3 of this Setup Procedure. 

OR 

To load a .ccx file  that was prepared for the amplifier/motor  

combination, see Copy Drive Data. Then proceed to Step 13 of this Setup 

Procedure. 

To load a .ccd file, click  and all the ccd files  

 

3. Enter Motor parameters. 

a. Click Motor  to open the Motor screen.  

b. To optionally load data from an existing motor data file, see Error! Reference 

source not found. and then skip to Step 4. 

4. Use Calculate to set initial gains and limits. 

a. Click Calculate  in the motor screen. The initial loop gains and limits are 

calculated. See Calculate. 

b. Load the calculated values into amplifier RAM by clicking OK. 

  

5. Configure digital I/O. 

a. Click Input/Output  on the Main screen to open the Input/Output 

screen. 

b. Verify the I/O settings described in Digital Inputs and Outputs. 
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c. On the Input/Output screen, click Close. 

  

6. Configure the command input. 

a. Click the appropriate button to configure the amplifier’s command input. 

      
For more information see Command Inputs.  

NOTE: If the amplifier is to run CVM programs or in Camming mode see the 

relevant documents. 

b. After setting command input parameters, Click Close. 

 

7. Configure faults. 

a. Click Configure Faults  in the Main screen to open the Fault 

Configuration screen and set latching faults as needed. See Error! Reference 

source not found.. 

b. Click OK to close the Fault Configuration screen. 

 

8. Configure an optional regen resistor. 

a. If the amplifier is equipped with a regen resistor, click Configure Regen 

 in the Main screen to open the Regen Settings screen. See Configure 

a Standard Copley Controls Regen Resistor for regen resistor parameters. 

b. Click OK to close the Regen Settings screen. 

  

9.  Phase and jog the motor. 

a. Apply AC or HV power.  

b. Phase  the motor.  See Auto Phase. 

c. Jog/move the motor to verify that the amplifier can drive the motor.  See Jog Mode. 

  

10.    Tune the control loops. 

a.   Starting with the Current Loop set up and tune all applicable Control Loops.  If you 

are setting up a linear motor, you can optionally Error! Reference source not 

found.. 

  

11.    Set gains and limits for stepper mode (stepper only) 

a. If tuning a stepper amplifier in stepper mode:  

• Set Position Limits in Stepper Mode.  See Position Limits (Stepper Amplifier)  

• If using Encoder Correction, set Encoder Correction 

• Tune Detent Compensation Gain 

  

12.   Configure Homing . 
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   See Homing. 

 

 

13.   Test with load attached 

a. On the CME Main screen, click Save to Flash. 

b. Remove amplifier power. 

c. Attach load. 

d. Reconnect amplifier power. 

e. If necessary, re-tune velocity and position loops. 

f. On the CME Main screen, click Save to Flash . 

g. On the CME Main screen, click Save to Disk (for backup or duplication). 

h. The amplifier tuning procedure is complete. 

NOTE: To copy the results of this setup to other amplifiers, see Drive Configuration or Copy 

Drive Data. 
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  SETUP 

 

4.1: Overview 
 

The Setup Wizard is used to set up the parameters that define the fundamental 

characteristics of the system.  This is where the motor, feedback and operating mode are 

setup.  The setup can be done three different ways: manually change settings, load 

settings from a ccx file or load settings from a ccd file.  Each of these methods are 

explained in this section. 

 

1.   Click  to open the Setup screen. 

                  

 

2. Review settings. 

3. Choose: 

Click Change Settings  to manually Change Setup Settings. 

OR  

If you have a .ccx file that was prepared for the amplifier/motor combination, click Load 

ccx File  and see Data Management Tools. 

OR  

If you have a .ccd file, click Load ccd file.  

4. To accept the displayed settings, click Cancel . 
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4.2: Change Setup Settings 
 

1. On the Setup screen, click Change Settings to manually change all Setup 

settings. Use the Back and Next buttons to navigate between screens. Screen details 

vary depending on amplifier model and mode selection. 

2. Set Motor Options. 
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3. Click Next to go to Feedback Options. 

          

Setting Description 

Hall Type Select Hall type: None, Digital, or Analog  

Hall Phase 
Correction 

If selected, will enable error checking between hall sensors and encoder 
phase angle.  

Motor Feedback Select type and source of motor feedback.  

• None: No motor encoder. 

• Primary Incremental: Incremental encoder on primary feedback 
connector. 

• Secondary Incremental: Incremental encoder on multi-mode port. 

• Panasonic Incremental A Format 

• SSI 

• EnDat 

• BiSS 

• Absolute A 

• Tamagawa Absolute A 

• Panasonic Absolute A Format 

• Panasonic Incremental A Format 

• Sanyo Denki Absolute A 

• Analog: Analog encoder on primary feedback connector. 

• Low Frequency Analog 

• Resolver: Resolver (–R) version of a Copley Controls amplifier on 

primary feedback connector. 

• CSR (Copley Serial Resolver) 

Additional encoder types are supported by certain Copley Controls 
amplifier models. See the amplifier data sheet for more information. 

Load Feedback Select type and source of load feedback. 

• None: No load feedback 

• Primary Incremental: Incremental encoder on primary feedback 
connector. 
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4. Note that this example shows setup for an incremental drive with Halls. For more 

information on Advanced Settings for Absolute and Serial Encoders refer to the Serial 

Encoder Guide. 

 

5. Click Next to go to Motor Feedback. 

 

              
 

 

 

• Secondary Incremental: Incremental encoder on multi-mode Port.  

• Analog: Analog encoder on primary feedback connector. 

Load Feedback 
Type 

Select the type of load feedback: 

• Rotary 

• Linear 

Use Load 
Feedback in 
Passive (Monitor) 
Mode 

When this is checked, the position of the load encoder will be reported 
by the passive load position variable but it will not be used to control 
the position of the axis.   

Stepper Drives Only 

Motor Encoder Select the encoder type: 

• None 

• Primary incremental 

• Absolute types 

Run in Servo 
Mode 

(Requires encoder) Amplifier operates as a true, closed loop, servo amplifier 
controlling a stepper motor.  

Enable 
Encoder 
Correction 

(Requires encoder) Amplifier runs as a stepper drive; encoder feedback is 
used to correct positional errors. See Encoder Correction 

http://www.copleycontrols.com/wp-content/uploads/2018/02/Using-Absolute-and-Serial-Encoders-Application-Notes.pdf
http://www.copleycontrols.com/wp-content/uploads/2018/02/Using-Absolute-and-Serial-Encoders-Application-Notes.pdf
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Feedback Parameters, Rotary 

 

Details for serial encoders can be found in the Serial Encoder Guide. 

 

Feedback Type Parameters/Actions 

Incremental 

 

In the Motor Encoder lines or Position Encoder lines field, enter the number of 
encoder lines (see encoder or motor data sheet). As indicated by the counts field, 
the number of encoder counts per revolution is equal to 4 x the number of lines. 
Enable Encoder Loss Detection and/or Index Loss detection if desired. 

 

Analog 

 

In Fundamental Lines, enter the number of fundamental encoder lines (see 
encoder or motor data sheet). As indicated by the Fundamental Counts field, the 
number of fundamental encoder counts per revolution is equal to 4 x the number of 
Fundamental Lines.  

 

Optionally modify the encoder resolution by changing the Interpolation value. The 

interpolated resolution (Interpolated Counts Per Rev) is the product of Fundamental 
Counts value and the Interpolation value. 

Resolver 

 

Optionally modify the feedback resolution by changing the value in Counts Per 
Rev. Default: 16384. 

 

Halls With amplifier set to Use Halls for Velocity/Position, optionally increase the 
counts per rev ratio by incrementing the Halls Count Multiplier. 
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Feedback Parameters, Linear 

 

Details for serial encoders can be found in the Serial Encoder Guide. 

 
Feedback Type Parameters/Actions 

Incremental Choose units and then enter the Encoder Resolution (see encoder or motor data 
sheet). Enable Encoder Loss Detection and/or Index Loss detection if desired. 

 

Analog 

 

Enter the Fundamental Pitch (distance between encoder lines; see encoder or 
motor data sheet). As indicated by the Fundamental Resolution field, Fundamental 
Pitch divided by four gives Fundamental Resolution. The interpolated resolution is 

the dividend of Fundamental Resolution value/Interpolation value. Optionally 
modify the Interpolated Resolution by changing the Interpolation value.  

 

Low Frequency 

Analog  

 

Normally used with ServoTube, Pole Pitch is the distance between poles in a pole 

pair, as entered in the Magnetic Pole Pair Length field on the Motor tab. The 
interpolated resolution is the dividend of Pole Pitch/Counts per pole value, 
expressed in micrometers. Optionally modify the resolution by changing the 
Counts/Pole value. Click Restore Default to restore default Counts/Pole. 
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6. Click Next to go to Load Feedback. 

            
 
 
        

7. Click Next to go to Brake/Stop tab. 

             

 

Many control systems employ a brake to hold the axis when the amplifier is disabled. On brake-

equipped systems, disabling the amplifier by a hardware or software command starts the 

following sequence of events.  
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1. The motor begins to decelerate (at Abort Deceleration rate in position mode or Fast 

Stop Ramp rate in velocity mode). At the same time, the Brake/Stop Delay Time 

count begins. This allows the amplifier to slow the motor before applying the brake. 

2. When response time has passed, the amplifier’s output stages are disabled. This delay 

ensures the brake has time to lock in before disabling the power section. 

 

Systems that do not employ brakes may still come to a controlled stop. On such systems, 

disabling the amplifier by a hardware or software command initiates the motor deceleration (at 

Abort Deceleration rate in position mode or Fast Stop Ramp rate in velocity mode). After the 

Brake/Stop Delay Time and any PWM delay response time, the drive will be disabled. This allows 

the amplifier to bring the motor to a controlled stop before disabling the drive. 

 

Note: This feature is not available when the amplifier is configured for current mode.  In 

this mode, the amplifier output turns off and the brake output activates immediately 

when the disable command is received. 

 

Parameter Description  

Brake/Stop Delay Time Time taken to stop the system.  

Range of accepted values: 0 to 10,000 mS 

Brake/Stop Activation 
Velocity 

Typical values are low to protect the brake mechanism (a few rpm).  

“0” disables velocity-based brake activation. 

PWM Delay Brake/Stop 
Response Time 

Time delay taken for the brake to engage after brake output is activated.  

Range of accepted values: 0 to 10,000 mS 

 

 

7. Click on Motor Wiring Detection tab. 

      
 

On some drives, the amplifier can check for a disconnected motor.  Upon enable, the amplifier 

will apply current to the motor windings, while keeping the brake engaged for the brake hold 
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time.  If the current vector cannot be applied, then a motor disconnected fault will occur, and 

the brake will not be released.  If the motor is connected, the brake will be released after the 

brake hold time expires. 

 

 

Parameter Description  

Brake Hold Time on 

Enable 

The time during which the amplifier is enabled, but the brake is engaged 

and the current is applied to the motor windings.   

Motor Check Current The amount of current to apply to the motor windings.   

 

 

8. Click Next to go to Operating Mode Options. 

 

           

 
 
 

Setting Description 

Operating 
Mode 

Choose the mode of operation: Current, Velocity, or Position. 
See Control Loops 

Command 
Source 

Choose the command input source (see Command Inputs): 

• Analog Command: Analog voltage provides command input.  

• PWM command (current and velocity mode only): Digital pulse-width 

modulated signal provides command input.  

• Function Generator: Internal function generator provides command input. 

• Software Programmed: The amplifier is controlled by software commands 

from either the Copley Virtual Machine (CVM) or an external source. See 
Copley Indexer Program User’s Guide or the Copley ASCII Interface 
Programmer’s Guide. 

• Camming: Runs in Camming Mode. See Copley Camming User Guide.  

• Digital Input: Command input is provided via the chosen Input Source 
(below).  
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• CAN or CANopen Over EtherCAT (CoE): Command input is provided over 
the CANopen or EtherCATnetwork. See the CANopen Programmer’s Guide.  

Digital Input 
Source  

 

Choose the input source for PWM or Digital input commands: 

• Single-ended Inputs: Command input is provided via two of the amplifier’s 
programmable digital inputs. 

• Multi-mode Port: Command input is provided via differential inputs on the 
amplifier’s multi-mode port. 

• Differential Inputs: Command is provided via differential inputs. 

• High Speed Inputs. Command is provided via two of the amplifier’s high 
speed inputs. 

 

9. Set Miscellaneous Options. 

     

Setting Description 

Commutation Commutation method: Sinusoidal, Trapezoidal, or Estimated Sinusoidal 

Use back EMF 
for Velocity 

If selected, will use the motor’s measured back EMF to determine motor 
velocity. Recommended only for medium- to high-speed. Accuracy depends 
on the accuracy of the programmed Back EMF value, and may be affected by 
factors such as cable resistance. 

Use Halls for 
Velocity and 
Position 

If selected, will use transitions of the Hall switches to determine motor 
velocity and position. Recommended only for medium- to high-speed 
applications (may run roughly at low speeds). 

Multi-mode 
Port 

Selects the mode for the amplifier’s multi-mode port: 

▪ Buffered Primary Feedback- The multi-mode port functions as a 
buffered digital encoder output based on the digital encoder input. 

▪ Differential Input. The multi-mode port functions as a differential 
command input. 

▪ Emulated Motor Feedback- The multi-mode port functions as an 
emulated digital encoder output based on the motor analog encoder 
or motor resolver and absolute encoders. 

 

10. When changes are complete, click Finish. The changes will be saved to Flash. 
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 MOTOR DATA 

5.1: Motor Data Screen Overview 
 

Contact Motor manufacturer to find the motor specifications for the motor being used. 

This data is useful for calculating tuning parameters for the math model in CME. All 

motor manufacturers have this information and may need to ask them for this data. 

 

If it is not possible to gather any information on motor data it may be possible to use 

Motor Plate Data located on the side of the motor.  Note that this may not be sufficient 

for most applications as it may not contain all of the necessary information for most 

applications. 

 

               
 

The Motor Feedback screen can be accessed by clicking the Feedback button. 

  

Action Name Description 

    
Save motor data  Saves motor/feedback/brake settings from PC to a file 

with .ccm name extension. 

    
Restore motor data  Restores contents of a .ccm file to PC. 

    
Save motor data to flash Saves motor/feedback/brake settings from PC to 

amplifier permanent flash memory. 

     
Calculate Calculates initial tuning and limit values. 

  

1. Click Motor  to open the Motor Data screen. 
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2. Choose Use Specification Data. 

     
OR  

 

Choose Use Motor Plate Data (Section 5.5) 

 

3. Load data from the file Error! Reference source not found.  . 

OR  

        Enter settings manually. 

4. Click Calculate  to calculate initial gains and limits. 

5. On the Main screen, click Save to Flash  to avoid losing the calculated data. 

 

                         

5.2: Rotary Motor Parameters  
 

  

Setting Description 

Manufacturer Motor manufacturer’s name. Saved for reference in the motor data file. 

Model Number Motor model number. Saved for reference in the motor data file. 

Units Selects whether the parameters entered in this screen are in Metric or English 
units. 

Motor Inertia The rotor inertia of the motor. Used for calculating initial velocity loop tuning 
values.  
Range: 0.00001 to 4,294 kg cm2. Default: 0.00001 kg-cm2. 

Number of Poles  (Brushless only.) The number of magnetic poles in the motor. Required for 
correct commutation of the motor. If the number of poles is not known,  

Verify the motor’s pole count using the Data accuracy test. Range: 2 to 200. 
Default: 4. 

Peak Torque  The peak torque that the motor can produce. Peak Torque divided by torque 
constant = motor’s peak current limit. Range: 0.0001 to 2,100 Nm. Default: 
0.0001 Nm. 

Continuous Torque  The continuous torque that the motor can produce. Used with the torque 
constant to calculate continuous current. Range: 0.0001 to 1,000 Nm. Default: 
0.0001 Nm. 

Velocity Limit Maximum speed of the motor. Used to calculate the velocity and acceleration 
limits for the velocity loop. Range dependent on encoder resolution. 

Torque Constant Relates the motor's input current to torque produced. Sometimes abbreviated 
as Kt.  
Range: 0.001 to 1,000 Nm/Apk. Default: 0.001 Nm/Apk. 

Back emf Constant Relates the motor's input voltage to speed. Sometimes abbreviated as Ke. Used 

for calculating the maximum velocity for a given amplifier bus voltage.  
Range: 0.01 to 21,000,000 V/Krpm. Default: 0.01 V/Krpm. 
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Resistance Motor resistance line-to-line. Used for calculating the initial current loop tuning 
values.  

Range: 0.01 to 327 . Default: 0.01 . 

Inductance Motor inductance line-to-line. Used for calculating the initial current loop tuning 
values.  
Range: see the hardware documentation. 

Stepper Amplifiers Only 

Rated Torque Motor’s rated operating torque. Min: .001. Max: 1000. 

Rated Current Motor’s rated continuous current. Min: 0.001. Max: 1000. 

Basic Step Angle Fundamental stepper motor step, in degrees. Min: 0.225. Max: 22.5. Default 
1.8. 

Microsteps/Rev Number of microsteps per revolution of the motor.  
Min: 4. Max: 100,000,000. Default 4000. 

Full Steps/Rev This read-only value can be used after entering Basic Step Angle to cross-check 

against motor data sheet.  

 

5.3:  Linear Motor Parameters 
 

Setting Description 

Manufacturer Motor maker’s name. Saved in the motor data file. Choose from list or enter 
manually. 

Model Number Motor model number. Saved in the motor data file. Choose from list or enter 
manually. 

Units Selects whether the parameters entered in this screen are in Metric or 
English units. 

Mass The mass of the motor. Used for calculating initial velocity loop tuning values.  
Range: .0001 Kg to 100,000 Kg. Default: .0001 Kg. 

Peak Force The peak force that the motor can produce. Peak Force divided by Force 
Constant = motor’s peak current limit. Range: 0.00001 to 2,000 N. Default: 
0.00001 N. 

Continuous Force The continuous force that the motor can produce. Used with the force 
constant to calculate continuous current. Range: 0.00001 to 1,000 N. 

Default: 0.00001 N. 

Velocity Limit Maximum speed of the motor. Used to calculate the velocity and acceleration 
limits for the velocity loop. Range dependent on encoder resolution.  

Force Constant Relates the motor's input current to force produced. Sometimes abbreviated 

as Kf.  
Range: 0.00001 to 2,000 N/Amp. Default: 0.00001 N/Amp. 

Back emf Constant Relates the motor's input voltage to speed. Sometimes abbreviated as Ke. 

Used for calculating maximum velocity for a given amplifier voltage. Range: 
0.01 to 1,000 V/M/Sec. Default: 0.01 V/M/Sec. 

Resistance Motor resistance line to line. Used for calculating the initial current loop 
tuning values. Range: 0.01 to 327 . Default: 0.01 . 

Inductance Motor inductance line to line. Used for calculating the initial current loop 
tuning values. Range: see the hardware documentation. 

Magnetic Pole Pair 
Length 

The length of a pair of magnets which equals the distance moved in one 
electrical cycle of the motor. 
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Stepper Amplifiers Only 

Rated Force Motor’s rated operating force. Min .001 N. Max 1000 N. 

Rated Current Motor’s rated continuous current. Min: 0.01 A. Max 1000 A. 

Full Step Fundamental stepper motor step distance. Min: 0.0001mm. Max: 5000 mm. 

Microsteps/ 

Full Step 

Number of microsteps per full step. Min: 1. Max: 100,000,000. 

5.4 Feedback Notes 

Encoder and Resolver Support 

Some Copley Controls amplifiers are offered in multiple versions to support different types of 

encoder or resolver feedback. Some encoder versions support digital quadrature encoders, some 

support analog sin/cos encoders, and others support both. Encoder versions normally require 

Halls for the commutation of brushless motors. The resolver versions support standard, single 

and multiple speed, transmit-type resolvers.  

 

Dual Feedback  

Some Copley Controls amplifiers can receive position feedback from sensors on the motor, the 

load, or both, through the Primary Feedback channel, a Secondary Feedback channel (multi-

mode port) or both. (Some amplifiers can also operate in certain modes without encoders or 

resolvers.) 

A drive configured with a multi-mode port can: 

• Provide a buffered digital encoder output based on the digital encoder input. 

• Provide an emulated digital encoder output based on the analog encoder or resolver 

input. 

• Provide a second digital encoder input to be used in the dual encoder position mode. In 

this mode, an encoder attached to the load provides position loop feedback, and the 

motor encoder or resolver provides velocity loop feedback. 

A dual-feedback setup is shown below. The amplifier receives feedback from an incremental 

motor encoder through the Primary feedback channel. Position (load) encoder feedback comes 

through the multi-mode port. The ratio of motor turns to position encoder turns is 1 to 10. 
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5.4: Calculate 
 

The Calculate function uses the motor data to calculate initial gains and limits. These can be 

modified to fine-tune the amplifier. Follow the steps below: 

 

1. Click Calculate  to calculate and display settings. 

 

        

2. Verify the peak current limit, continuous current limit, and velocity loop velocity limit. If 

one or more of these values seems inappropriate, click Cancel and check: Peak Torque 

(or Force), Continuous Torque (or Force), Velocity Limit, and Torque (or Force) Constant. 

Correct them if needed. See Error! Reference source not found. . See Error! 

Reference source not found. or Error! Reference source not found.. 

Error! Reference source not found.If the Motor values are correct but the peak current 

limit, continuous current limit, or velocity loop velocity limit values are not optimal for 

the application, change these limits during the tuning process. 

3. Save the values into amplifier RAM by clicking OK. 

 

NOTE: When loading motor data from a file, if the motor wiring configuration in the motor 

file does not match the configuration currently stored in the amplifier, CME prompts for 

verification on which configuration to use. Select the file configuration by clicking Yes. 

The configuration will be tested as part of Motor Phasing. 

4. On the Main screen, click Save to Flash  to avoid losing the calculated data. 
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5.5: Use Motor Plate Data 
1. Choose Use Motor Plate Data. 

         
         

 

2. Enter Rated Speed. 

 

3. Enter Rated Current. 

 

4. Enter Rated Torque or Power from the motor label. 

 

Note: The Rated Torque will be defaulted to a minimum value. 

         The Rated Torque should not be 0. 

         The Rated Torque will be calculated if motor Power is entered. 

 

 

 

 

 

 

 

 

 

 

5. Click Characterize and Tune and follow the instructions in the Characterize and Tune 

wizard.  

 

 

 

 

 

 

 

 

 

 

 

 

 

Parameter Description 

Rated Speed Speed of the motor at which it produces its 
rated (maximum) power, when the specified 
(rated) voltage is given at its rated Load. 

Rated Current Maximum safe continuous current of the motor 

Rated Torque Maximum safe continuous torque of the motor 

Power Continuous safe motor power 
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Characterize and Tune 

        

This section allows users to tune the current drive setup.  

 

To begin tuning, select an option under the Steps selection, and click the Start button. 

 

 
 

Below is an example of auto-tuning starting from the Current Loop Auto Tune.  Note that users 

can begin auto-tuning at any step, and do not need to follow this order. 

 

1. Click Start to start the Current Loop Auto tune. 
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2. When the current loop auto tune is complete, it goes to Auto Phase. 

 
 

3. Press <Jog or Jog> depending on which direction you want the motor rotating. 

 

4. Click Next and answer the question(s) that pop up. 
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5. When the auto phase is complete, it goes to Velocity Loop Auto Tune. 
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 DIGITAL INPUTS AND OUTPUTS 

6.1:  Digital Inputs 
 

Click Input/Output  on the Main screen. A typical screen is shown below.    

Options vary with model and configuration. 

 

       
 

Red light: inhibited motion or active input depending on input function.
Grey light: motion not inhibited.

No light: not configured.

Lo/Hi: indicated state of input.

Hold position setting. Indicates input is used as a CAN address bit.

Parameter Description 

Pull up +5 V Pulls up the group of inputs up to internal +5 V. 

Pull down Pulls the group of inputs down to internal signal ground. 

Debounce 
Time 

Specifies how long an input must remain stable at a new state before the amplifier 
recognizes the state. Increase to prevent multiple triggering caused by switch bounce 
upon switch closures. Range: 0 to 10,000 mS. 

Debounce does not affect inputs that have been configured as PWM, Pulse and 
Direction, or Quadrature control inputs. 

IN1- INn Select the function for the input.  

Axis How many axes the drive has. 

*Hold position 
when limit 
switch is 

active 

Available in position mode only:   

When one or more inputs are configured as a limit switch (NEG Limit-HI Inhibits, 
NEG Limit-LO Inhibits, POS Limit-HI Inhibits, or POS Limit-LO Inhibits). The *Hold 
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Digital Input Functions 

 

Depending on the mode of operation, some inputs may have a predefined function such as 

enable or motor temperature sensor. Typically, IN1 is defined as an enable input. 

 

Input Function Description 

AMP Enable- 

LO Enables with clear faults 

A low input will enable the amplifier. 

Any transition will clear latched faults and outputs. 

AMP Enable- 
HI Enables with clear faults 

A High input will enable the amplifier. 
Any transition will clear latched faults and outputs. 

AMP Enable- 
LO Enables with reset 

A low input will enable the amplifier. 

A low to High transition will reset the amplifier. 

AMP Enable- 
HI Enables with reset 

A High input will enable the amplifier. 

A High to low transition will reset the amplifier. 

AMP Enable-LO Enables A low input will enable the amplifier. 

AMP Enable-HI Enables A High input will enable the amplifier. 

Not Configured No function assigned to the input. 

POS Limit-HI Inhibits* A High input will inhibit motion in positive direction. 

POS Limit-LO Inhibits* A low input will inhibit motion in positive direction. 

NEG Limit-HI Inhibits* A High input will inhibit motion in negative direction. 

NEG Limit-LO Inhibits* A low input will inhibit motion in negative direction. 

Reset on LO-HI Transition A low to Hi transition of the input will reset the amplifier. 

Reset on HI-LO Transition A High to low transition of the input will reset the amplifier. 

Motor Temp HI Disables A High input will generate a Motor Over Temperature fault. 

Motor Temp LO Disables A low input will generate a Motor Over Temperature fault. 

Home Switch Active HI A High input indicates the home switch is activated.  

Home Switch Active LO A low input indicates the home switch is activated. 

Motion Abort Active HI A High input causes the amplifier to stop motion, using the Abort 

Deceleration rate described in Trajectory Limits. The amplifier 
remains enabled. 

Motion Abort Active LO A low input causes the amplifier to stop motion, using the Abort 
Deceleration rate described in Trajectory Limits. The amplifier 
remains enabled. 

High Res Analog Divide Active HI A High input causes the firmware to divide the level of the analog 
input signal by 8.  

position option prevents any motion while a limit switch is active. This option uses 
the Abort Deceleration rate to stop the motor as described in Trajectory Limits. 

 

CAUTION: If the amplifier is switched back to current or velocity mode with 
this option selected, the limit switches will no longer function 

Restore 
Defaults 

Restores all inputs and outputs to factory defaults. 
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High Res Analog Divide Active LO A low input causes the firmware to divide the level of the analog 
input signal by 8. 

Amp Disable-HI with AC Removed  

Amp Disable-LO with AC Removed  

Trajectory Update on LO-HI 
Transition 

 

Trajectory Update on HI-LO 
Transition 

 

PWM Sync Input PWM synchronization input. Synchronizing PWM Switching 
Frequency. (For high-speed inputs only.) 
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6.2: Digital Outputs 
 

A typical Digital Outputs screen is shown below.   

 

            
 

Note: Options vary with models and configurations. 

 

Digital Output Functions 

 

Output Function Description 

Not Configured No function. Output remains Hi/Off. 

Fault Active High Output goes Hi/Off when one or more faults are detected.  

Fault-Active Low Output goes Lo/On when one or more faults are detected.  

Brake-Active High (Brake hold) Output goes Hi/Off to activate the brake.  

Brake-Active Low (Brake release) Output goes Lo/On to activate the brake.  

PWM Sync Output  The PWM synchronization output.  

Custom Event See Custom Triggered Event Output 

Custom Trajectory Status See Custom Trajectory Status Triggered Output. 

Custom Position Triggered Output See Custom Position Triggered Output. 

Program Control Active High Output state controlled by CVM or external program. 

Program Control Active Low Output state controlled by CVM or external program 

External Regen Active High Used to turn On/Off at set voltage points. See AN136. 

External Regen Active Low Used to turn On/Off at set voltage points. See AN136. 

STO Status-Active On/Off EDM external device monitoring for STO (Safe Torque Off) 

Axis 

Indicates the state 

of the output On/Off 

or Hi/Lo 

http://www.copleycontrols.com/wp-content/uploads/2020/02/Accelent-External-Regen-AN.pdf
http://www.copleycontrols.com/wp-content/uploads/2020/02/Accelent-External-Regen-AN.pdf
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ID Switch and Network LED SLI 

 

 
 

Uncheck the box to disable Network ID switch and LED to get additional I/O (3 outputs, 1 

input). 

 

6.3:  Custom Event Triggered Output 
 

Digital outputs can be configured for one or more bits in the Event Status (faults, 

warnings, and status). 

1. Choose Custom Event for the output configuration, then click Configure Custom to 

open the Event Triggered Output screen. 
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2. Select one or more events from the list.  Selections are OR’ed together, so that any event 

will cause the output to go active. The Clear button clears all selections. 

3. Choose Output Active High/Off or Output Active Low/On. 

4. To latch the output, set the Latch Output option.  

 

Latching an output does not eliminate the risk of unexpected motion 
with non-latched faults. 

 

Associating a fault with a latched, custom-configured output does not latch   
the fault itself. After the cause of a non-latched fault is corrected, the 

amplifier re-enables without operator intervention. In this case, motion may      
restart unexpectedly.  

Failure to heed this warning can cause equipment damage, injury, or death. 

 

5. Click OK to save changes to amplifier RAM and close the screen 

 

Event Description 

Amplifier Fault A latched fault is active. 

Amp Over Temperature  

 

 

For descriptions of these fault events, see Error! Reference source 
not found. 

Motor Phasing Error 

Feedback Error 

Motor Over Temp 

Under Voltage 

Over Voltage 

Short Circuit 

Current Limited The current output is being limited by the I2T Algorithm or a latched 
current fault has occurred. 

Voltage Limited Current loop is commanding the full bus voltage to control current. 
Commonly occurs when the motor is running as fast as the available 
bus voltage will allow. 

Positive Limit Switch Axis has contacted positive limit switch. 

Negative Limit Switch Axis has contacted negative limit switch. 

Amp Disabled by Hardware Amplifier enable input(s) is not active. 

Amp Disabled by Software Amplifier is disabled by a software command. 

Attempting to Stop Motor The amplifier, while in velocity or position mode, has been disabled. 
In velocity mode, amplifier is using the Fast Stop Ramp described in  

Velocity Loop Limits. In position mode, the amplifier is using the Abort 

Deceleration rate described in Trajectory Limits.  
The output remains active until the amplifier is re-enabled. 

Motor Brake Active Motor brake activated.  

PWM Outputs Disabled The amplifier’s PWM outputs are disabled. 

Positive Software Limit Actual position has exceeded the positive software limit setting.  

See Homing. 

Negative Software Limit Actual position has exceeded the negative software limit setting.  
See Homing 

!
DANGER 
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Following Error Following error has reached programmed fault limit.  

See Following Error Faults 

Following Warning Following error has reached programmed warning limit.  

See Following Error Faults 

Position has Wrapped The position counters have exceeded the maximum range of  

-231 – 231-1 and have wrapped. Normal amplifier operation is not 
affected.  

Velocity Limited The velocity command (from analog input, PWM input, or position loop) 
has exceeded the velocity limit. See Velocity Loop Limits 

Acceleration Limited In velocity mode, motor has reached an acceleration or deceleration 
limit that was set as described in Velocity Loop Limits 

Pos Outside of Tracking 
Window 

The following error has exceeded the programmed value. 
See Position and Velocity Tracking Windows 

Home Switch Active Axis has contacted the home limit switch.  

In Motion The motor is moving, or it has not yet settled after a move. The amplifier 

is settled when it comes within the position tracking window and stays 
there for the tracking time at the end of a move. Once this bit is set, it 

remains set until a new move is started. 

Vel Outside of Tracking 
Window 

Difference between target and actual velocity has exceeded the window. 
See Position and Velocity Tracking Windows 

Phase not Initialized Amplifier is using Phase Initialization function and phase is not 
initialized. 

Command Input Fault PWM or other command signal (e.g., EtherCAT master) not present. If 
Allow 100% Output option is enabled by a setting Bit 3 of Digital Input 
Command Configuration this fault will not detect a missing PWM 
command.  

 

 

Latched vs. Non-Latched Custom Event 

An output that is configured for a custom event can be latched or non-latched.  

If a non-latched output goes active, it will go inactive as soon as the last of the selected events 

is cleared.  If a latched output goes active, it remains active until at least one of the following 

actions has been taken:  

• Reset or power-cycle the amplifier. 

• Cycle (disable and then enable) an input that is configured as Enable with Clear Faults or 

Enable with Reset. 

• Open the Control Panel and press Clear Faults or Reset. 

 

The latched/non-latched behavior of an output configured as a custom event is independent of 

the drive’s latched/non-latched fault.  Consider the following example: 

 

OUT3 is configured as a custom event: under voltage and latched, but the Under-Voltage 

fault on the Configure Faults screen is set to non-latched.  The table below shows the 

difference in behavior between the output and the drive’s fault    

Condition Drive OUT3 

Under voltage condition 

occurs 

Disables PWM outputs, and reports 

under voltage faults 

Goes to active state 

Under voltage condition 

is corrected 

Under voltage fault is not reported 

and PWM outputs are enabled 

Stays active 
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6.4: Custom Trajectory Status Triggered Output 
Digital outputs can be configured for one or more events in the Trajectory Status. 

1. Choose Custom Trajectory Status for an output and then click Configure Custom to 

open the Trajectory Status Triggered Output screen. 

 

             

2. Select one or more events from the list.  Selections are OR’ed together, so that any event 

will cause the output to go active. 

  

Status Description 

Homing Error Activate output if an error occurred in the last homing attempt 

Referenced (Homed) Activate output if the most recent homing attempt was successful 

Homing in Progress Activate output when a homing move is in progress 

Move Aborted Activate output if move is aborted 

Trajectory Generator 
Running 

Activate output while trajectory generator is generating a move 

Camming Buffer Error A camming buffer error has occurred  

3. Choose Output Active High to have the output go high when active or Output Active Low 

to have the output go low when active. 

4. Click OK to save changes to amplifier RAM and close the screen. 

 

6.5: Custom Position Triggered Output  
 

1. Choose Custom Position Triggered Output for an output and then click Configure 

Custom to open the In Position Triggered Output screen. 
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2. Select one of the configurations described below and enter appropriate values for the 

parameters.  

Configuration Description and Parameters 

In Position Window Activates the output while the axis is in the window between the programmed 

Upper and Lower positions.  

Trigger at Position Activates the output for the programmed Time when the axis travels through 
the programmed Position. 

Trigger Positive 
Motion 

Activates the output for the programmed Time when the axis travels in the 
positive direction through the programmed Position. 

Trigger Negative 
Motion 

Activates the output for the programmed Time when the axis travels in the 
negative direction through the programmed Position. 

3. Choose Output Active High to have the output go high when active or Output Active Low to 

have the output go low when active. 

4. In stepper mode with no encoder, choose Use Limited Position. Otherwise choose Use 

Actual Position. 

5. Click OK to save changes to amplifier RAM and close the Custom Output Configuration screen. 

 

6.6: Synchronizing PWM Switching Frequency 
 

In some situations, such as when sampling small analog signals, it is desirable to synchronize 

the PWM switching frequency among multiple amplifiers. In these cases, one amplifier serves as 

a master for one or more slave amplifiers. The PWM sync output of the master sends a signal 

that is received as a PWM sync input by each slave.  To configure this, an output of the master 

must be configured as PWM Sync Output and one input on each of the slaves must be configured 

as PWM Sync Input. 
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6.7: Analog I/O 
 

A typical Analog I/O screen is shown below. Currently, only the Xenus Plus single axis drive has 

analog I/O functionality. 

 

       

Analog Motor Temperature Sensor 

Enter a voltage limit in mV. Fault will occur when voltage is above limit. Actual voltage is the 

sensor reading in mV. 

 

       
 

 

Analog Output 

The Analog Output has three modes of operation - Manual, Actual Current and Actual Velocity. 

When Manual is chosen the output is set to the programmed value, +/- 5V, entered in mV. 
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When Actual Current is chosen, the output value is proportional to the actual motor current. 

    

 

When Actual Velocity is chosen  

    

 COMMAND INPUTS 

7.1:  Analog Command Settings  

   Click the Analog Command button  on the Main screen. 

 

  
 

Parameter Description 

Scaling Current mode: output current produced by +10 Vdc of input.  

Range: 0 to 10,000,000 A. Default: Peak Current value. 

Velocity mode: output velocity produced by +10 Vdc of input.  

Range: 0 to 100,000 rpm (mm/sec).  
Default: Maximum Velocity value. 

Position mode: position change (counts or mm) produced by +10 Vdc of input. 

Range: 0 to 1,000,000,000 counts.  
Default: 1 Revolution of a rotary motor or 1 pole pair distance for a linear motor. 

For more information, see Scaling 
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Dead Band Sets dead band. Range: -10,000 to 10,000 mV. Default: 0. 

For more information, see Dead Band 

Invert Command Inverts polarity of amplifier output with respect to input signal. 

Offset (Current and Velocity modes only.) Used to offset input voltage error in an open 
loop system. Not recommended for use when the amplifier is part of a closed loop 
system.  

Range: -10,000 to 10,000 mV. Default: 0. For more information, see Offset 

 

Analog Command Notes 

The amplifier can be driven by an analog voltage signal through the analog command input. The 

amplifier converts the signal to a current, velocity, or position command as appropriate for 

current, velocity, or position mode operation, respectively.  The analog input signal is 

conditioned by the scaling, dead band, and offset settings. 

 

Scaling 

The magnitude of the command generated by an input signal is proportional to the input signal 

voltage. Scaling controls the input-to-command ratio, allowing the use of an optimal command 

range for any given input voltage signal range.  

For example, in current mode, with default scaling, +10 Vdc of input generates a command 

equal to the amplifier’s peak current output; +5 Vdc equals half of that. 

Scaling could also be useful if, for example, the signal source generates a signal range between 

0 and +10 Vdc, but the command range only requires +7.5 Vdc of input. In this case, scaling 

allows the amplifier to equate +7.5 Vdc with the amplifier’s peak current (in current mode) or 

maximum velocity (in velocity mode), increasing the resolution of control.  

 

Dead Band  

To protect against unintended response to low-level line noise or interference, the amplifier can 

be programmed with a “dead band” to condition the response to the input signal voltage. The 

amplifier treats anything within the dead band ranges as zero and subtracts the dead band value 

from all other values. For instance, with a dead band of 100 mV, the amplifier ignores signals 

between –100 mV and +100 mV, and treats 101 mV as 1 mV, 200 mV as 100 mV, and so on. 

                        
Input
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Offset 

To remove the effects of voltage offsets between the controller and the amplifier in open loop 

systems, CME 2 provides an Offset parameter and a Measure function. The Measure function 

takes 10 readings of the analog input voltage over a period of approximately 200 ms, averages 

the readings, and then displays the results. The Offset parameter allows the user to enter a 

corrective offset to be applied to the input voltage.  

The offset can also set up the amplifier for bi-directional operation from a uni-polar input voltage. 

An example of this would be a 0 to +10 Vdc velocity command that had to control 1000 rpm 

CCW to 1000 rpm CW. Scale would be set to 2000 rpm for a +10 Vdc input and Offset set to -

5V. After this, a 0 Vdc input command would be interpreted as -5 Vdc, which would produce 

1000 rpm CCW rotation. A +10 Vdc command would be interpreted as +5 Vdc and produce 1000 

rpm CW rotation. 

 

Monitoring the Analog Command Voltage 

The analog input voltage can be monitored in the Control Panel and in the Scope Tool. The 

voltage displayed in both cases is after both offset and deadband have been applied. 
 

Analog Command in Position Mode 

The Analog Position command operates as a relative motion command. When the amplifier is 

enabled the voltage on the analog input is read. Then any change in the command voltage will 

move the axis a relative distance, equal to the change in voltage, from its position when enabled. 

To use the analog position command as an absolute position command, the amplifier should be 

homed every time it is enabled. The Homing sequence may be initiated by CAN, ASCII serial, or 

CVM Indexer program commands.  

 

7.2:   PWM Input Settings 
 

  Click the PWM Command button  on the Main screen. 
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Parameter Description 

Scaling Current mode: output current at 100% duty cycle.  

Range: 0 to 10,000,000 A. Default: Peak Current value. 

Velocity mode: output velocity at 100% duty cycle.  
Range: 0 to 100,000 rpm (mm/sec).  
Default: Maximum Velocity value. 

PWM Input Type One wire 50% or two wire 100% with direction. 

Options Invert PWM input: Inverts the PWM logic. 

Allow 100% output: Overrides the 100% command safety measure.  
See Failsafe Protection from 0 or 100% Duty Cycle Commands 

Invert Sign Input: In 100% duty cycle mode, inverts the polarity of the directional 
input. 

 

50% Duty Cycle (One-Wire) 

The input takes a PWM waveform of fixed frequency and variable duty cycle. As shown 
below, a 50% duty cycle produces zero output from the amplifier. Increasing the duty 
cycle toward 100% commands a positive output and decreasing the duty cycle toward 

zero commands a negative output.  

 
The command can be inverted so that increased duty cycle commands negative output 
and vice versa. 

 

100% Duty Cycle (Two-Wire) 

One input takes a PWM waveform of fixed frequency and variable duty cycle, and the 
other input takes a DC level that controls the polarity of the output. A 0% duty cycle 
creates a zero command, and a 100% duty cycle creates a maximum command level. 
The command can be inverted so that increasing the duty cycle decreases the output 

and vice versa. 

Decreasing Duty Cycle Increasing Duty Cycle

Max -

Max +

0

PWM Input

Amplifier Output

50 % Duty Cycle
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Failsafe Protection from 0 or 100% Duty Cycle Commands 

In both formats, the amplifier can be programmed to interpret 0 or 100% duty cycle as 
a zero command, providing a measure of safety in case of controller failure or cable 
break. 

7.3:   Digital Position Input Settings 
 

  Click the Digital Input button  on the Main Screen. 

 

           
 

Parameter Description 

Control Input Pulse and Direction: One input takes a series of pulses as motion step 
commands, and another input takes a high or low signal as a direction 
command. 

Pulse Up / Pulse Down: One input takes each pulse as a positive step 
command, and another takes each pulse as a negative step command. 
Quadrature: A/B quadrature commands from a master encoder (via two 
inputs) provide velocity and direction commands. 

Max +

0

PWM Input

Amplifier Output

Direction Input

100%

Duty Cycle

100%

Duty Cycle

Min -
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Increment position 

on 

Rising Edge: Increment position on the rising edge of the input pulse. 

Falling Edge: Increment position on the falling edge of the input pulse. 

Stepping Resolution Input Pulses: Number of Input Pulses required to produce output counts.  
Range: 1 to 32,767. Default: 1. 

Output Counts: Number of Output Counts per given number of input pulses.  
Range: 1 to 32,767. Default: 1. 

Invert Command When selected, inverts commanded direction. 

 

Pulse Smoothing 

In digital position mode, the amplifier’s trajectory generator can be used to create 
trapezoidal profiles, with programmed acceleration, deceleration and velocity, from a 
simple pulse train or burst of pulses.  To bypass the trajectory generator while in digital 

or analog position modes, set   the maximum acceleration to zero. The only limits in 
effect will now be the velocity loop velocity limit and the current limits. (Note that 

leaving the maximum acceleration set to zero will prevent other position modes from 
operating correctly.) 

Pulse and Direction 

In pulse and direction format, one input takes a series of pulses as motion step 
commands, and another input takes a high or low signal as a direction command, as 

shown below. 

 
The amplifier can be set to increment position on the rising or falling edge of the signal. 

Stepping resolution can be programmed for electronic gearing. 

 

 

Count Up/Count Down 

In the count up/count down format, one input takes each pulse as a positive step 
command, and another takes each pulse as a negative step command, as shown below. 

 

Pulse Input 

Velocity 
Command 

Direction Input 
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The amplifier can be set to increment position on the rising or falling edge of the signal. 

Stepping resolution can be programmed for electronic gearing. 

 

 

Quadrature 

In quadrature format, A/B quadrature commands from a master encoder provide 
velocity and direction commands, as shown below.  

 
The ratio can be programmed for electronic gearing. 

 

 

 

 

 

 

 

 
  

 

Up Input 

Velocity 
Command 

Down Input 

B Input

Velocity

Command

A Input
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7.4: Software Programmed Input Settings 
These settings can be saved to flash to allow default conditions to be set and used when 

the amplifier is powered up or reset. 

 

Programmed Position 

  Click the Programmed Position button  on the Main screen. 

 

       
 

Setting Description 

Move Relative or Absolute. 

Type Trap or S-Curve. 

Distance Move distance (relative) or location (absolute) 

 

 

Programmed Velocity 

 

  Click the Programmed Velocity button  on the Main screen. 
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DANGER 

Potential for unexpected movement. 

If the Programmed Velocity is set to values other than 0, 
the motor will move after power-up or reset if the amplifier 
is hardware enabled.  

Failure to heed this warning can cause equipment 
damage, injury, or death. 

 

Setting Description 

Programmed 

Velocity 

Move velocity. Units: rpm (rotary) or mm/s (linear). 

 

 

Programmed Current 

 

  Click the Programmed Current button  on the Main screen. 

 

      
 

 
DANGER 

Potential for unexpected movement. 

If the Programmed Current is set to values other than 0, 
the motor will move after power-up or reset if the amplifier 
is hardware enabled.  

Failure to heed this warning can cause equipment 
damage, injury, or death. 

 

Setting Description 

Programmed 
Current 

Current applied during the constant velocity portion of the move. Units: A.  

Current Ramp Acceleration/deceleration current. Units: mA/s. 

 

 

 

 

 

 

 

 

 

!

!
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 NETWORK CONFIGURATION 

 

8.1: CANopen Network 
 

 

A CANopen network can support up to 127 nodes. Each node must have a unique and valid 

seven-bit address (Node ID) in the range of 1-127. (Address 0 should only be used when the 

amplifier is serving as a CME 2 serial port multi-drop gateway.) 

 

1. Verify that the CAN network has been cabled and terminated as per amplifier 

documents. 

2. Click CAN Configuration  to open the CAN Configuration screen. (If 

CAN is not the Position Loop Input, choose Amplifier→Network Configuration 

instead). 

                

 

3. Choose network type (CAN or DeviceNet). This is optional for some drives. 

 

4. Choose a Bit Rate and choose any combination of address sources (Switch, Inputs, 

and Programmed Value). The address is the sum of the values from these sources. 

5. For each source selected, perform the additional steps described below. 

Source Additional Steps 

Use Switch Verify the S1 switch setting. (Assigns values for Bit 0 – Bit 3 of CAN 

address.) 

Use Inputs Enter Number of Inputs, then choose inputs to represent each CAN 
address bit. 

Use Programmed 
Value 

Enter the Programmed Value.  
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6.  Click Save & Reset to save changes to amplifier flash, close the screen, and reset 

the amplifier. Click Save & Close to save changes to amplifier flash without 

resetting.  

NOTE: Address and bit rate changes take effect only after power-up or reset. 

 

8.2: MACRO Network 
 

A Delta Tau PMAC card can hold up to four MACRO IC’s, each of which is a master on a MACRO 

ring. Each master IC can address 16 stations (nodes, slaves), enabling the addressing of up to 

64 devices on a ring. Of these, 32 can be motion devices such as Xenus XML. A node address 

is an 8-bit value with bits 7-4 addressing the master IC and bits 3-0 addressing the slave. 

XML switch S1 is set to select the master IC to which the Xenus will be linked. The four possible 

values for this setting are 0,1,2, and 3. 

As a MACRO station or node the XML has eight available addresses as a motion control device. 

These are 0,1,4,5,8,9,12, & 13.  

 

 

1. Verify the S1 and S2 switch settings. 

2.  Select Amplifier→Network Configuration from the CME Main Screen to open the 

MACRO Configuration screen as shown in the following example. 

                

 

Parameter Description 

Scaling Input 
Command 

Current mode: output current produced by +10 Vdc of input.  
Range: 0 to 10,000,000 A. Default: Peak Current value. 

Velocity mode: output velocity produced by +10 Vdc of input.  
Range: 0 to 100,000 rpm (mm/sec).  

Default: Maximum Velocity value. 

Heart Beat Time Out The frequency at which the drive will produce heartbeat messages. This 
parameter may be set to zero to disable heartbeat production. 

Home Status Bit Use Motor Encoder index: Return the primary encoder index state in 
the home status bit of the MACRO status word. 
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Use Home Input: The state of any general purpose input configured as 
a home input will be returned in the home status bit of the MACRO status 

word. 

Auxiliary Data 
Registers 

Defines what type of additional data is transmitted in the Auxiliary data 
registers of every MACRO response message. 

First Register: Digital input Value, Secondary Analog Input Value. 

Second Register: Analog Input, Motor Encoder, Position Encoder. 

Enable Position 
Output Scaling 

When selected, position data sent over the MACRO network is shifted up 
5 bits to be compatible with Delta-Tau controllers. 

Enable MACRO 
Network 
Synchronization 

 

Allows the drive’s PWM frequency to be adjusted to allow synchronous 
operation with the MACRO ring. Note that changing the PWM Frequency 
will affect the current loop tuning. Therefore, current loop tuning will need 

to be checked. 
Current Loop 
Frequency 

Active Network 

Required for Amp to 

Enable 

If selected, drive will not enable if network is not active. 

 

8.3: EtherCAT Network 
 

An EtherCAT network enables high-speed control of multiple axes while maintaining tight 

synchronization of clocks in the nodes. Data protocol is CANopen over EtherCAT (CoE) based on 

DSP-402 for motion control devices.  

 

Stations on EtherCAT are automatically addressed by their bus location. The first drive on the 

network is station address -1. The second is -2, and so on. 

 

As an alternate to the default addressing, switches S1 and S2 may be used to program a station 

alias. The default address and station alias are always available. If the switch-based station alias 

is used, it is the responsibility of the user to ensure that each drive has a unique station alias. 

 

To access Network Configurations, click the Amplifier options and then select Network 

Configuration in the options menu. 
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EtherCAT Address (Station Alias) 

 

Use Switches 

 

1. View the S1 and S2 switch settings on the drive. 

2. Verify the S1 and S2 switch settings select Amplifier→Network Configuration from 

the CME 2 Main Screen to open the EtherCAT Settings screen as shown in the 

following example. 

Note: S1 is x10 and S2 is x1. S1 counts by decimal 16.  

                            

 

Use Programmed Value 

To use the the programmed value for the drive, select the Use Programmed Value radial 

button.  When clicking the Save and Close button the value entered into the Programmed 

Value field saves the alias to Flash. 

 

  

 FAULTS 

9.1: Overview 
 

Latched vs Non-latched Faults 

When a fault is configured to be latched, the fault can only be cleared after the fault has 

been corrected and at least one of the following actions has been taken: 

• Power-cycle the amplifier 

• Cycle (disable and then enable) an input that is configured as  

Enable with Clear Faults or Enable with Reset 

• Open the Control Panel and press Clear Faults or Reset 

• Clear the fault over the CANopen network or serial bus 

 

A non-latched fault will be cleared when the fault condition has been removed.  This can 

occur without operator intervention.  
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DANGER 

 

 

 

Risk of unexpected motion with non-latched faults. 

After the cause of a non-latched fault is corrected, the amplifier re-

enables the PWM output stage without operator intervention. In this 

case, motion may re-start unexpectedly. Configure faults as latched 

unless a specific situation calls for non-latched behavior. When using 

non-latched faults, be sure to safeguard against unexpected motion. 

Failure to heed this warning can cause equipment damage, 

injury, or death. 

 

Example 

The drive’s temperature reaches the fault level.  The drive reports the fault and disables 

the PWM output. Then, the drive temperature falls below the fault level. 

 

Non-latched fault operation: 

The fault is cleared and the amplifier’s PWM outputs are enabled without operator 

intervention. 

 

Latched fault operation: 

The fault remains active and the drive’s PWM outputs remain disabled until the faults are 

cleared as described above. 

 

 

1.  Click the Configure Faults button  on the Main screen. 

                

!
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2. Select the faults to latch. See Fault Descriptions. 

3. Click OK to close screen and save changes to amplifier RAM. 

4. On the Main screen, click Save to Flash to avoid losing the changes. 

 

  

9.2:  Fault Descriptions  
 

Note: The list of faults may vary with amplifier model. 

 

Fault Description Fault Occurs When… Fault is Corrected When… 

*Amp Over 
Temperature 

Amplifier's internal temperature 
exceeds specified temperature. 

Amplifier’s internal temperature 
falls below specified temperature. 

Motor Phasing Error Encoder-based phase angle does not 
agree with Hall switch states. This fault 
can occur only with brushless motors 
set up using sinusoidal commutation. It 

does not occur with resolver feedback or 
with Halls correction turned off.  

Encoder-based phase angle 
agrees with Hall switch states. 
See Troubleshoot Manual Phase 
w/ Encoder and Halls 

*Feedback error 

 

Over current condition detected on 
output of the internal +5 Vdc supply 
used to power the feedback.  

Resolver or analog encoder not 
connected or levels out of tolerance.   

Differential signals from incremental 
encoder not connected. 

Encoder power returns to 
specified voltage range. 

Feedback signals stay within 

specified levels. 

Differential signals connected. 

*Motor Over Temp Motor over-temperature switch changes 
state to indicate an over-temperature 

condition. 

Temperature switch changes back 
to normal operating state. 

Under Voltage Bus voltage falls below specified voltage 
limit. 

Bus voltage returns to specified 
voltage range. 

Over Voltage Bus voltage exceeds specified voltage 

limit. 

Bus voltage returns to specified 

voltage range. 

*Following Error User set following error threshold 
exceeded. 

See Following Error Fault Details 

*Short Circuit Detected Output to output, output to ground, 
internal PWM bridge fault. 

Short circuit has been removed. 

Command Input Lost PWM or other command signal not 

present. 

Command signal restored. 

Over Current (Latched) Output current I2T limit has been 
exceeded. 

Amplifier is reset and re-enabled. 

Motor Wiring 
Disconnected 

The drive detects that it cannot push 
current through the motor windings 

The motor is reconnected. 

STO Active STO Activated for safe torque off STO is deactivated and fault is 
cleared 

*Latched by default. 
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 MOTOR PHASING 

10.1: Auto Phase 
The examples in this chapter show amplifier operating modes and motor feedback 

configurations. Some screens and choices may vary from those described here. 

 

Auto Phase Example: Servo Amplifier 

 

NOTE: The following steps show Auto Phase with a brushless rotary motor, digital Halls, and an 

incremental quadrature encoder. Screens vary for other configurations. 

 

1. Verify that the Enable Input is not activated and that HV or AC power is applied. 

2. Click Auto Phase  to open the Auto Phase wizard. 

 

              

3.  Move the motor in the direction to be considered positive 

OR 

If you cannot move the motor, click Skip (you will confirm motor direction later). 

 

NOTE: If an output is configured as a brake you can temporarily release the brake by 

holding down the Release Brake button. The brake will be reactivated when you release 

the button. 
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4.  Click Next to go to the Motor Wiring Setup step:

 

 

5.  Activate the Enable Input. 

6.  Click Start to begin the motor wiring setup. 

The message area displays messages: Configuring Initial Settings, Microstepping, 

Test Complete, Motor Wiring has been configured. 

During microstepping, a current vector is applied to the motor windings and microstepped 

through an electrical cycle at a set rate, causing the motor to move. 

If you chose to Skip the motor direction setup step, Auto Phase will prompt for confirmation of 

correct motor direction. 

If the step fails, see Troubleshooting the Auto Phase Problems. 

NOTE: If incorrect values were entered for inductance and resistance, the calculated Cp and 

Ci values may produce current loop oscillation, evidenced by an audible high frequency squeal 

during auto phasing. 

 

7.  Click Next to go to the Phase Count Test step. 
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8.  Click Start to begin the Phase Count Test. Observe status messages. See the prompt:  

     

9.  When you are ready to observe motion, click OK. 

When motion is complete the prompt will be displayed: 

                    

     

If motor did not turn 1 full turn, click No and see Phase count test. 

If motor turned 1 full turn, click Yes. 

10.  For a resolver (–R) version of a Copley Controls amplifier, skip to Step 12.  

 For a non-resolver amplifier, click Next to open the Hall Wiring Setup screen. 

      

                      

11. Click Start to begin the Halls wiring setup. The message area displays the messages: 

Microstepping. Test Complete. Motor has been properly phased. 

During microstepping, a current vector is applied to the motor windings and 

microstepped through an electrical cycle at a set rate, causing the motor to move. As 

the motor moves the Hall lines are decoded for proper commutation. 

If the step fails, see Halls wiring setup. 

 

12.  For a resolver (-R) version of a Copley Controls amplifier, click Next to open the     

Resolver Phase Angle Setup screen. 
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13.  Click Start to start the resolver phase angle setup. The message area displays status   

messages.  

14.  Click Finish to close the screen and save values to flash memory 

OR to close the screen without saving changes, click Cancel. 

15.  If the Auto Phase algorithm does not produce desired results, try adjusting the Auto 

Phase Current and Increment Rate values, using the guidelines in  

Tips for Auto Phase Current and Increment Rate.  

16.  If desired results are not obtained, or to confirm results, proceed to Manual Phase. 

Auto Phase Example: Stepper Amplifier, No Encoder 

1. Verify that the Enable Input is not activated and that HV power is applied. 

2. Click Auto Phase to open the Auto Phase Motor Direction Setup screen. 

                     

3. Hold down Move POS to move the motor in the direction considered positive, and 

observe the direction of movement. 

If the motor does not move see Troubleshooting the Auto Phase Problems 

4. If the motor moved opposite the direction that you wish to program as positive, click 

Invert Motor Output. 

5. Click OK to save the direction setting. 
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Auto Phase Example: Stepper Amplifier with Encoder, in Stepper Mode 

 

1. Verify that the Enable Input is not activated and that HV power is applied. 

2. Click Auto Phase  to open the Auto Phase Motor Direction Setup screen. 

 

 

3.  Move the motor in the direction you wish to be considered positive. 

4.  Activate the Enable Input. 

5.  Click Next to open the Auto Phase Motor Wiring Setup screen. 

     

6.  Click Start to begin motor wiring setup with default values.  

After successful motor wiring setup, the message “Test Complete” appears. 

7.  Click Finish to close the screen and save values to flash memory. 

 

 

 

 

 

 

 

 



Digital Inputs and Outputs    

85 Copley Controls 

Auto Phase Example: Stepper Amplifier with Encoder, in Servo Mode  

 

1. Verify that the Enable Input is not activated and that HV power is applied. 

2.   Click Auto Phase  to open the Auto Phase Motor Direction Setup screen. 

 

3.  Move the motor in the direction you wish to be considered positive. 

4.  Activate the Enable Input. 

5.  Click Next to open the Auto Phase Motor Wiring Setup screen. 

         

 

6.  Click Start to begin the motor wiring setup. 

The message area displays messages: Configuring Initial Settings, Microstepping, 

Test Complete, Motor Wiring has been configured. 

During microstepping, a current vector is applied to the motor windings and 

microstepped through an electrical cycle at a set rate, causing the motor to move. 

If you chose to Skip the motor direction setup step, Auto Phase will prompt for 

confirmation of correct motor direction. 

If the step fails, see Troubleshooting the Auto Phase Problems 

NOTE: If incorrect values were entered for inductance and resistance, the 

calculated Cp and Ci values may produce current loop oscillation, evidenced by an 

audible high frequency squeal during auto phasing. 
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7. Click Next to open the Auto Phase Count Test screen. 

  

8. Click Start to begin the Phase Count Test. Observe status messages. See the 

prompt:  

 

 

9.  When you are ready to observe motion, click OK. See the prompt: 

  

10. Click Next to open the Auto Phase Motor Phase Initialize screen: 
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11.  Click Initialize Phase to start phase initialization. If successful, this message 

appears: “Test Complete. Phasing has been initialized.” 

12.  Click Finish to close the screen and save values to flash memory. 

13.  After clicking Finish, the following message appears if changes were made: 

 

14.  Click OK. 

10.2: Tips for Auto Phase Current and Increment Rate 
• If friction is high, more current may be required to move the load. 
• High static friction may require more current to overcome stiction. 

• Transition from static friction to dynamic friction, and back, may produce jerky motion. 

• A faster increment rate will operate in the dynamic friction range. 

• A slower rate will operate in the static friction range. 

• If the friction is low, as in the case of air bearings, low frequency oscillations may occur; 

thus, less current and slower rates may be required. If oscillations persist, then friction 

may need to be temporarily added. 

 

10.3: Troubleshooting the Auto Phase Problems 

Motor direction setup 

If motor direction setup step failed: 

• Check Encoder or resolver power and signals. 

• Verify that the encoder is differential. (Contact factory if encoder is single-ended.) 

• Check shielding for proper grounding. 

 

Motor wiring setup 

If motor wiring setup step failed: 

• Verify that amplifier is disabled. 

• Check for mechanical jamming. 

• Check for smooth motion with no mechanical jerking. 

• Check for good connections to the motor power wires. 

• Disconnect motor power wires and measure for proper motor resistance. 

 

Phase count test 

If phase count test failed:  

• Verify that in the Motor/Feedback screen the following parameters have been set 

correctly: 

• Number of Poles for rotary motors. Verify the motor’s pole count with the Data accuracy 

test. 

• Magnetic Pole Pair Length for linear motors. 

• Encoder Lines or Fundamental Lines for rotary encoders. 

• Encoder Resolution for linear encoders. 
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Halls wiring setup 

If Halls wiring setup step failed: 

• Check Halls power and signals. 

• Check for smooth motion with no mechanical jerking. 

• Check shielding for proper grounding. 

 

If the auto phase procedure fails despite these corrective measures, see Manual Phase. 

 

 

10.4: Manual Phase 
 

1. Remove load from the motor. 

2. On the Main screen, choose Tools→Manual Phase to open the window: 

 
 

3. Verify the Current setting before enabling the drive. 

          

4. To control the current vector rotation, command the motor forward or reverse. 

                  
NOTE: Some motors have bearings stiction, so helping the motor with mechanical force is 

acceptable. Motors with no friction may need friction added to steady motion. 

 

5. If the motor cannot keep up with the rate of vector rotation, then reduce the 

Increment Rate or increase the Current. 

6. Verify that pressing forward button moves motor forward.  

If the motor moves in the wrong direction, toggle the Motor Invert Output setting. 

7. Verify actual position count agrees with direction of rotation: increasing counts in 

forward direction and decreasing counts in reverse direction. If it does not, toggle the 

Motor Feedback Invert Input box setting. 

8. If the motor has no Halls, skip to Phase Initialization for Motor without Halls. 

9. Monitor the vector rotation through one electrical cycle for proper Hall transitions: 
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▪ Verify that the red indicator rotates in the same direction as the motor phase angle, 

and that the transition occurs when the needle is between indicators (±30 degrees, as 

shown below). 

                                      
▪ If the needle and Hall states do not track properly, use the Hall Wiring list box and/or 

Invert Input options (shown below) to swap the amplifier’s Hall wire configuration. 

 

        
 

▪ If the red indicator transition leads or lags behind the centered needle by more than 30 

degrees, then try adjusting the Hall Offset in +/- 30 degree increments: 

            
 

10.  Phasing of a motor with encoder and Halls is complete. Click OK.  

Phase Initialization for Motor without Halls 

The Phase Initialization is designed to phase a motor with no Halls.  

 

DANGER 

Halls are strongly recommended for safe, redundant system. 

Copley strongly recommends the use of Halls or a commutating 

encoder for commutation to provide a safe, redundant system. If the 

application requires otherwise, the customer accepts responsibility 

for verifying system performance and reliability. 

Failure to heed these warnings can cause equipment damage, 

injury, or death. 

 

The Phase Initialization function uses as little motion as possible (less than 1/3 of one electrical 

cycle) to determine phasing. Phase Initialization drives the motor in open loop current mode, 

using microstepping of a current vector. 

 

 

 

  

!
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1. Ensure that the motor is free to move (for instance, make sure the brake is OFF). 

2. Ensure that no external force, such as gravity, will cause the motor to move. If it is 

not practical to eliminate such forces, it may be necessary to use the Forced Phase 

feature later in this procedure. 

3. To phase a motor with an encoder and no Halls, click Initialize Phase . 

Observe the status messages under Monitor.  

4. If the message “Phase Initialized” appears, the phasing of a motor with encoder and 

no Halls is complete. Click OK to close the Manual Phase window. 

  

If the phasing function fails (for instance, message 

“Phase Initialized” is not displayed, or if a phasing fault 

is indicated) adjust the phase initialization settings 

described below and try Step 4 (Initialize Phase) again. 

 
 

 

 

 

Setting Description 

Time Used first as a delay, allowing amplifier to ramp up current to drive a small 
move. Then used as a settling time. If the value is too low, the settling 
may not occur in time, possibly resulting in jerky motion. Default: 400 ms. 

Current Use to overcome stiction when rotating current vector. If the current is too 
large, motion may not settle; a low value may not provide enough current 
to drive a move.  

Forced Phase When selected, Forced Phase causes the Phase Initialization function to 
apply Phase Init Current to alternate pairs of motor wires using the Phase 
Init Time. Forced Phasing has been used to overcome various phasing 
problems, including situations where gravity introduces unwanted motion. 

Forced Phasing tends to produce more jerk and apparent motion.  

Increment Phase 
90 deg 

If set, the amplifier will increase the starting phase angle by 90 degrees 
after every failed initialization attempt.  

Use Offset If set, the amplifier uses the Hall Offset value as the initialization starting 
angle. 

 

Manual Phase Example: Motor with Resolver 

 

1. Make sure that no load is connected to the motor. 

2.  On the Main screen, choose Tools→Manual Phase to open the window: 
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3.  Verify the Current setting before enabling the drive 

           
 

To control the current vector rotation, command the motor forward or reverse. 

 

NOTE: Some motors have bearings stiction, so helping the motor with mechanical 

force is acceptable. Motors with no friction may need friction added to steady 

motion. 

4.  If the motor cannot keep up with the rate of vector rotation, then reduce the 

Increment Rate or increase the Current. 

5.  Verify that pressing forward button moves motor forward. If it does not, toggle the 

Motor Invert Output box setting. 

6.  Verify actual position count agrees with direction of rotation: increasing counts in 

forward direction and decreasing counts in reverse direction. If it does not, toggle 

the Motor Feedback Invert Input box setting. 

7.  Adjust Resolver Offset configuration as required, testing Fwd and Rev, to produce 

alignment of Motor Phase Angle with Resolver Angle as shown here. 
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Note: Motor manufacturers typically align the resolver in 30 degree increments, 

typically by applying current through a pair of motor power wires. 

 

10.5: Troubleshoot Manual Phase w/ 
Encoder and Halls 

To perform trapezoidal commutation after power-up or reset, the amplifier must receive good 

Hall signals. After the first Hall transition is detected, then sinusoidal commutation can be 

performed. In sinusoidal commutation, the amplifier uses the encoder for commutation while 

monitoring the Halls to verify proper phase. If the error between the encoder count and Hall 

transition is too large, then the Hall phase correction will not be performed and a phase fault 

will be triggered. 

Test for phase fault problems in the order shown below. 

Data accuracy test 

1. Verify the motor’s pole count: 

• Apply a current vector at zero Increment Rate to lock motor in position. 

• Turn the motor shaft and count the number of distinct locking positions. 

• Calculate the number of poles: Poles = number of locking positions * 2 

2. Verify the encoder line count OR a linear motor's magnetic pair length and the encoder 

resolution. 

Encoder wiring test 

If the Halls produce good trapezoidal commutation but a phase fault is persistent in sinusoidal 

commutation mode, the encoder is highly suspect: 

• Verify the differential encoder signals.  

• Verify proper twisted shielded cable with good grounding.  

• Disable the amplifier and move the motor manually to test for phase fault.  

• If phase fault only occurs under command of current, make sure the motor power cable 

is not bundled with the encoder cable. 

 

Hall signals test 

If the Halls signals are suspected to be faulty: 

• Make sure Halls change states as the motor moves through one electrical cycle. 

• Some Hall signals are noisy and require filtering. Check with motor manufacturer. 

• Some Halls are not properly calibrated to the motor manufacturer’s specification. 

 

Hall transition test 

If the location of the Hall transition is not within +/-30 degrees: 

• Adjust Hall offset in smaller increments. 

• Verify Hall alignment. 

• Make sure motion is smooth. 
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 CONTROL LOOPS 

11.1: Current Loop Setup and Tuning 
 

Initial current loop proportional gain (Cp) and current loop integral gain (Ci) values can be 

calculated with Calculate. 

 

  Click I Loop  to open the Current Loop screen: 

           
 

  

 Parameter Description 

 Peak Current Limit Used to limit the peak phase current to the motor. Max value depends 

upon the amplifier model; Min value > continuous limit. 

 I2T Time Limit Sets I2T Time Limit in ms. See I2T Limit Algorithm. 

 Continuous Current Limit Used to limit the Phase Current. Max Value is < Peak Current and 
depends upon the amplifier model. Min value: 0 

 Current Loop Offset Sets current loop offset. Leave it set to zero until after tuning. For more 
information, see Offset 

 Cp Current loop proportional gain. Range 0 – 32,767. 

 Ci Current loop integral gain. Range 0 – 32,767. 

 Current Ramp (mA/s) Used only when in current mode. Default value is 0 which disables the 
ramp rate limit. 

 Drive Output Maximize Smoothness: Amplifier uses circular vector limiting to 
produce smooth operation even into the voltage limits. 

Maximize Speed: Allows for slightly more of the bus voltage to be used 
when in the voltage limit. This may produce a small disturbance at top 

speed. 

 Enable Bus Clamping  

 Auto Tune See Current Loop Auto Tune 
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 Bandwidth Measure bandwidth using the Cp and Ci values now in the amplifier. 

 

 

 Manually tune the Current Loop 
 Apply square-wave excitation to the current loop and adjust current loop 

proportional gain (Cp) and current loop integral gain (Ci) to obtain a desired 

waveform.  

 

 
 

NOTE:  

▪ During tuning, observe any warnings or faults that appear in the status 

bar of the scope. 

▪ Some users prefer the Auto Tune feature. See Current Loop Auto Tune.  

 

 
1. Click the Scope Tool .  

 
2. Choose Current  from the Function Generator Apply 

To: list. 

3.  On the Settings tab, make sure Auto Setup  is selected. Auto Setup 

automatically sets the following parameters: 

4. Verify that the Amplitude value  is not excessive for the motor. 

5. Click Start . 

                 

6. On the Gains tab, adjust current loop proportional gain (Cp): 

 Function Generator Tab 

 Parameter Description 

 Function Square Wave. 

 Amplitude 10% of continuous current value. 

 Frequency 100 Hz.  

 Settings Tab 

 Channel 1 Commanded current (green). 

 Channel 2 Actual current (white). 
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▪ Set current loop integral gain (Ci) to zero.  

▪ Raise or lower Cp to obtain desired step response. (Typically, little or no 

overshoot with a 100 Hz, low-current square wave.) If the Cp value is too 

large, ringing may occur. If the Cp value is too low, bandwidth decreases. 

7. Adjust current loop integral gain (Ci) until desired settling time is obtained. 

8. Press Stop  to stop the function generator. 

9. On the Main screen, click Save to Flash to avoid losing the changes. 

10. Navigate to the Iloop screen and click on Bandwidth to measure the bandwidth.    

Verify that the bandwidth measured is sufficient for the application. Typical 

bandwidth value is 1.2kHz ± 200 Hz.  

 

11.2:  Current Loop Auto Tune 
The current loop Auto Tune algorithm applies a square-wave command to the current loop 

and adjusts current loop proportional gain (Cp) and current loop integral gain (Ci) until a 

desirable waveform is obtained. 

Initial current loop proportional gain (Cp) and current loop integral gain (Ci) values can be 

calculated with Calculate. 

  

1. Click I Loop  to open the Current Loop screen: 
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2. Verify that the amplifier is hardware enabled. 

3. Click Auto Tune  to open the screen and start the Current Loop Auto 

Tune. 

    
 

4.  To Change the Auto Tune Current click Stop.  Enter the new current in the Auto 

Tune Current field, and then click Start. 

5.  Observe the Auto Tune process and results. 

A typical example is given below: 

▪ Set Cp and Ci to zero and adjust Cp and Ci for optimal values. 
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▪ Use a frequency sweep to determine the small signal, current loop bandwidth. 

         

 

▪ A set of Cp and Ci alternatives, and the bandwidth measured using the high Cp and Ci values 

are displayed. 

            

 

6.  Choose an action based on Auto Tune results. 

▪ Choose which set of values to save: High, Medium, Low, or Original. 

The Medium values, selected by default, are appropriate for most applications. 

▪ Optionally choose how to save: Save Cp and Ci to Flash  

or Keep Cp and Ci in amplifier RAM only. 

7.  Click OK to save the values as chosen and close the Auto Tune Results window. 
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11.3: Notes on the Current Mode and Current Loop  

Current Loop Diagram 

As shown below, the “front end” of the current loop is a limiting stage. The limiting stage accepts 

a current command, applies limits, and passes a limited current command to the summing 

junction. The summing junction takes the commanded current, subtracts the actual current 

(represented by the feedback signal), and produces an error signal. This error signal is then 

processed using the integral and proportional gains to produce a command. This command is 

then applied to the amplifier’s power stage. 

 

Current Loop Inputs 

• The amplifier’s analog or PWM inputs. 

• A CANopen network via the amplifier’s CAN interface.  

• A Copley Virtual Motion (CVM) control program. 

• The amplifier’s internal function generator. 

In velocity or position modes, the current command is generated by the velocity loop.  

Offset 

The current loop offset is intended for use in applications where there is a constant force applied 

to, or required of, the servomotor and the system must control this force. Typical applications 

would be a vertical axis holding against gravity, or web tensioning. This offset value is summed 

with the current command before the limiting stage. 

Limits 

The current command is limited based on the following parameters: 

Limiter Description 

Peak Current 
Limit 

Maximum current that can be generated by the amplifier for a short duration of 
time. This value cannot exceed the peak current rating of the amplifier. 

Continuous 
Current Limit 

Maximum current that can be constantly generated by the amplifier.  

I2T Time Limit Maximum amount of time that the peak current can be applied to the motor before 

it must be reduced to the continuous limit or generate a fault. 

For more details, see I2T Time Limit Algorithm. 

Note: Although the current limits set by the user may exceed the amplifier's 
internal limits, the amplifier operates using both sets of limits in parallel, and 

therefore will not exceed its own internal limits regardless of the values 
programmed.  

Ramp Rate of change in current command. Used to limit jog moves initiated from the 
Control Panel Jog function in current mode, and in advanced Indexer Program 

functions. 

 

Current Command

PWM

Command

Current Limiter

Current Loop

Feedback (Actual Current)Limits:

Peak Current

Continuous Current

Peak Current Limit Time

Current Integral Gain (Ci)

Current Proportional Gain (Cp)
Limited Current +

-

+

+
Motor

Current Offset
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Current Loop Gains 

 

Gain Description 

Cp - Current loop 
proportional 

The current error (the difference between the actual and the limited 
commanded current) is multiplied by this value. The primary effect of this gain 

is to increase bandwidth (or decrease the step-response time) as the gain is 
increased. 

Ci - Current loop 

integral 

The integral of the current error is multiplied by this value. Integral gain 

reduces the current error to zero over time. It controls the DC accuracy of the 
loop, or the flatness of the top of a square wave signal. The error integral is 
the accumulated sum of the current error value over time.  

Current Loop Output 

The output of the current loop is a command that sets the duty cycle of the PWM output 
stage of the amplifier. 

11.4: Velocity Loop Setup and Tuning 
 

Initial velocity loop proportional gain (Vp) and velocity loop integral gain (Vi) values can be 

calculated with Calculate. 

 Click the V Loop button  on the Main screen (contents vary with model and 

configuration): 

 

          

 

Parameter Description 

Velocity Limit Top speed limit. Max value may depend upon the back EMF & the Encoder 

value. Min value: 0. 

Acceleration Limit Maximum acceleration rate. Max value may depend upon load, inertia, & 

peak current. Min value: 1. (Does not apply in position mode.) 

Deceleration Limit Maximum deceleration rate. Max value may depend upon load, inertia, & 

peak current. Min value: 1. (Does not apply in position mode.) 

Tracking Window 
See Position and Velocity Tracking Windows 

Tracking Time 

Vp Velocity loop proportional gain. Range: 0 to 32,767.  
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Vi Velocity loop integral gain. Range: 0 to 32,767. 

Fast Stop Ramp Deceleration rate used by the velocity loop when the amplifier is hardware 

disabled. Range: 0 to 100,000,000. Default: velocity loop Decel. Limit 
value.  

Low Gains Shift Increases the resolution of the units used to express Vp and Vi, providing 
more precise tuning. For more information, see Velocity Gains Shift 

Hi Gains Shift Decreases the resolution of the units used to express Vp and Vi, providing 
more precise tuning. For more information, see Velocity Gains Shift 

Vi Drain (integral 

bleed) 

Vi drain modifies the effect of velocity loop integral gain. The higher the 

Vi Drain value, the faster the integral sum is lowered. Range: 0 to 32,000. 
Default: 0. 

Vcff Velocity loop command feed forward. The input command to the velocity 

loop (after limiting) is scaled by this value and added to the output of the 
velocity loop. 

 

 
 Manually Tune the Velocity Loop 

Apply square-wave excitation to velocity loop and adjust proportional gain (Vp) and 

integral gain (Vi) to obtain desired waveform. For instance:  

 

 
 

NOTE: During tuning, observe any warnings that appear to the left of the trace. 

1. Click the Scope Tool .  

2. Choose Velocity from the Function Generator Apply 

To: list. 

3. On the Settings tab, make sure Auto Setup  is selected.  

Auto Setup automatically sets the following parameters: 

Function Generator Tab 

Function Square Wave 

Amplitude 10% of maximum velocity value 

Frequency  5 Hz 

Settings Tab 

Channel 1  Limited velocity (green) 

Channel 2  Actual Motor Velocity (white) 
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4. Verify that the amplitude value  is not excessive for the 

motor. 

5. Click Start . 

6. On the Gains tab, adjust velocity loop proportional gain (Vp): 

▪ Set velocity loop integral gain (Vi) to zero. 

▪ Raise or lower proportional gain (Vp) to obtain desired step response. 

(Typically, little or no overshoot on a 5 Hz small, slow-speed square wave.) 

7. Adjust velocity loop integral gain (Vi) until desired settling time is obtained. 

8. Click Stop  to stop the function generator. 

9. On the Main screen, click Save to Flash  to avoid losing the changes. 

11.5: Notes on the Velocity Mode and Velocity Loop 

Velocity Loop Diagram 

As shown below, the velocity loop limiting stage accepts a velocity command, applies limits, and 

passes a limited velocity command to the input filter. The filter then passes a velocity command 

to the summing junction. The summing junction subtracts the actual velocity, represented by 

the feedback signal, and produces an error signal. (The velocity loop feedback signal is always 

from the motor feedback device even when an additional encoder is attached to the load.) The 

error signal is then processed using the integral and proportional gains to produce a current 

command. Programmable digital filters are provided on both the input and output command 

signals. 

 

Inputs 

In velocity mode, the velocity command comes from one of the following: 

• The amplifier’s analog or PWM inputs.  

• A CANopen network via the amplifier’s CAN interface.  

• A Copley Virtual Motion (CVM) control program. 

• The amplifier’s internal function generator. 

In position mode, the velocity command is generated by the position loop. 

Velocity Loop Limits 

The velocity command is limited based on the following set of parameters designed to protect 

the motor and/or the mechanical system. 

 

Limiter Description 

Velocity Limit Sets the maximum velocity command input to the velocity loop. 

Velocity

Command
Current

Command

Velocity Limiter

Velocity Loop

Feedback (Derived Velocity)

Limits:

Velocity

Acceleration*

Deceleration*

Emergency Stop Deceleration*

   *Not used w hen velocity loop is controlled by position loop. See "Velocity Loop Limits" for details.

Velocity Integral Gain (Vi)

Velocity Proportional Gain (Vp)

Limited

Velocity +

-

+

+

FilterFilter
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Acceleration 

Limit 

Limits the maximum acceleration rate of the commanded velocity input to the 

velocity loop.  

This limit is used in velocity mode only. In position mode, the trajectory generator 
handles acceleration limiting. 

Deceleration 

Limit 

Limits the maximum deceleration rate of the commanded velocity input to the 

velocity loop. 

This limit is used in velocity mode only. In position mode, the trajectory generator 
handles deceleration limiting. 

Fast Stop Ramp Specifies the deceleration rate used by the velocity loop when the amplifier is 

hardware disabled. (Fast stop ramp is not used when amplifier is software 
disabled.) If the brake output is active, the fast stop ramp is used to decelerate 
the motor before applying the brake.  

Note that Fast Stop Ramp is used only in velocity mode. In position mode, the 
trajectory generator handles controlled stopping of the motor. There is one 

exception: if a non-latched following error occurs in position mode, then the 
amplifier drops into velocity mode and the Fast Stop Ramp is used. 

Diagram: Effects of Limits on Velocity Command 

The following diagram illustrates the effects of the velocity loop limits. 

 

Velocity Loop Gains 

The velocity loop uses these gains: 

Gain Description 

Vp - 

Velocity 
loop 
proportional 

The velocity error (the difference between the actual and the limited 

commanded velocity) is multiplied by this gain. The primary effect of this 
gain is to increase bandwidth (or decrease the step-response time) as the 
gain is increased. 

Vi -  
Velocity 

loop integral 

The integral of the velocity error is multiplied by this value. Integral gain 
reduces the velocity error to zero over time. It controls the DC accuracy of 

the loop, or the flatness of the top of a square wave signal. The error 
integral is the accumulated sum of the velocity error value over time. 

Velocity Gains Shift  

The Velocity Gains Shift feature adjusts the resolution of the units used to express Vp 
and Vi, providing more precise tuning. If the non-scaled value of Vp or Vi is 64 or less, 

the Low Gains Shift option is available to increase the gains adjustment resolution. 
(Such low values are likely to be called for when tuning a linear motor with an encoder 

Commanded Velocity

Limited Velocity

Vel Limit

Accel Limit Decel Limit
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resolution finer than a micrometer.) If the non-scaled value of Vp or Vi is 24001 or 
higher, the High Gains Shift option is available to decrease the gains adjustment 

resolution. 

Velocity Loop Filters 

See Standard Filter Types. 

Velocity Loop Outputs 

The output of the velocity loop is a current command used as the input to the current 
loop. 

Proper Tracking Over Time 

As described earlier, position error is the difference between the limited position output 
of the trajectory generator and the actual position. Velocity error is the difference 
between commanded and actual velocity. 

When the position or velocity error exceeds the programmed tracking window value, a 

status word bit is set. The bit is not reset until the error remains within the tracking 
window for the programmed tracking time.  

 

Velocity Tracking Illustration 

The following diagram illustrates the use of tracking window and time settings in 
velocity mode. 

 
 

11.6:  Position Loop Setup and Tuning 
 

Initial position loop proportional gain (Pp), velocity feed forward (Vff), and acceleration feed 

forward (Aff) values can be calculated with Calculate. 

 

± Tracking Window

Tracking
Time

Limited Velocity

Actual Velocity

Tracking Window
Output
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  Click the P Loop button  on the Main screen. 

 

         
 

Parameter Description 

Aff Acceleration feed forward. Range: 0 to 32,767. See Trajectory Limits 

Vff Velocity feed forward. Range: 0 to 32,767. 100% Vff: 16,384.  
Trajectory Limits 

Pp Position loop proportional gain. Range: 0 to 32,767. See Trajectory Limits 

Gains Multiplier Position loop output is multiplied by this value before going to the velocity 

loop. In dual encoder systems, the multiplier’s initial value is calculated based 
on the ratio of motor encoder turns to position encoder turns. 

Following Error 

Fault 
The level (in encoder counts) at which the following error produces a fault, 

which stops the servo loop. We recommend raising the fault level before 
tuning the loop.  
See Following Error Faults 

Following Error 

Warning 
The level (in counts) at which the following error produces a warning (without 

stopping the loop). See Following Error Warnings 

Disable Fault Stops following error from faulting. See Following Error Faults 

Tracking 
Window 

Width of tracking window in counts. See Position and Velocity Tracking 
Windows 

Tracking Time Position must remain in the tracking window for this amount of time to be 
considered tracking. See Position and Velocity Tracking Windows 

Pi Position loop integral gain 

Pd Position loop derivative gain 

Pi Drain Position loop integral drain 

Enable PID Enables the PID parameters 

Click the Position Wrap button . 
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Change/verify the position wrap parameters as needed. Set both values to zero to 

disable position wrapping. Note that the changes do not take effect until OK is pressed. 

For more information about this feature, see Position Wrap. 

Parameter Description 

Motor Position 

Wrap 

Position at which the actual motor position count returns to zero. In a single 

feedback system, it also applies to the actual load position.  

Load Position 

Wrap 

Position at which the actual load position count returns to zero in dual 

feedback systems. If the position encoder is set to passive mode, this value 
applies to the passive encoder position. 

 

 

Click on the Trajectory Values tab. 

      

 

Parameter Description 

Max Velocity Maximum trajectory velocity. Max value may depend upon the back EMF and 

the Max feedback count. Min:0. Default: 0.25 x motor velocity limit. 
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Max Accel Maximum trajectory acceleration. Max value may depend upon the load 

inertia and peak current. Min:0. Default: 0.5 x velocity loop Accel. Limit value. 

Max Decel Maximum trajectory deceleration. Max value may depend upon the load 
inertia and peak current. Min:0 (disables limit). Default: 0.5 x velocity loop 

Accel. Limit value. 

Abort Decel Deceleration rate used by the trajectory generator when motion is aborted. 
Min:0. Default: 0.5 x velocity loop Accel. Limit value. 

Jerk Rate of change of acceleration. The value of jerk set during the calculate 
procedure produces an S-Curve whose maximum slope is equal to the 
trajectory profile slope. This value will produce a maximum acceleration that 
is not more than the initial default value of acceleration. Small values will 

produce less jerking but will take longer to complete move. Large values will 
produce more jerking and a more trapezoidal profile but will complete the 
move faster. 

Note that setting limits to zero disables the trajectory generator so that the command input is 

not limited by the generator. Velocity is only limited by the Velocity Limit set in the Velocity 
Loop. 

  

 

 Manually Tune the Position Loop 

 Minimize following error and oscillation by running profiles and adjusting position 

proportional gain (Pp), velocity feed forward (Vff), acceleration feed forward (Aff) and 

other settings. For instance: 

 

  
 

NOTE: During tuning, observe warnings that appear to the left of the trace. 

1. Click the Scope Tool .  

 

2. Select the Profile tab . 

 
3. On the Settings tab, make sure Auto Setup  is selected. Auto Setup 

automatically sets the following parameters: 
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Profile Tab 

Move Relative 

Type Trap 

Distance 2000 counts  

Reverse and 
repeat 

Not selected 

Settings Tab 

Channel 1 Profile velocity (green) 

Channel 2 Following error (white) 
 

 4. If the Auto Setup default profile distance is not appropriate, enter an 

appropriate short distance .  

 5. Click Start . The Profile Generator executes a short move. 

NOTES:  

▪ The profile may not reach constant velocity during a short move. 

▪ If a following error occurs, open the Control Panel and click Clear Faults. 

 

6.   

 and  

 

Set up a trapezoidal profile by setting the trajectory limits and distance. See table: 

Trajectory Limits Tab 

Maximum Velocity 

Set values typical of those expected to be used in the application. 
Maximum 

Acceleration 

Maximum 

Deceleration 

Profile Tab 

Distance Set the move distance to produce a complete trajectory profile. Be 
sure that this distance does not exceed mechanical limits of the 

system. 

Move Relative 

Type Trap 

   

7. Adjust position proportional gain (Pp) to minimize following error:  

• On the Gains tab, set velocity feed forward (Vff) and acceleration feed forward (Aff) to 

zero. 
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• On the Profile tab, click Start. On the Gains tab, adjust position loop proportional gain 

(Pp) until best result is obtained.  

• Click Start after each adjustment to test on a new profile move. 

                  
NOTES:  

1. Too much position loop proportional gain (Pp) might cause oscillation. 

2. If a following error occurs, open the Control Panel and click Clear Faults. 

8. Adjust velocity feed forward (Vff): 

▪ Velocity feed forward (Vff) reduces following error in the constant velocity portion of 

the profile. Often, a velocity feed forward (Vff) value of 16384 (100%) provides best 

results. 

▪ Click in the Vff field and adjust the value.  

▪ Click Start after each adjustment to test on a new profile move. 

 

9. Adjust acceleration feed forward (Aff): 

▪ Acceleration feed forward (Aff) reduces following error during profile acceleration and 

deceleration. 

▪ Click in the Aff field and adjust the value.  

▪ Click Start after each adjustment to test on a new profile move. 

NOTES:  

1) If, after tuning the position loop, the motor makes a low frequency audible noise while 

enabled but not moving, the velocity loop gains (Vp and Vi) may be lowered to reduce the 

noise. If the gain values are set too low, the response to instantaneous rates of change 

might be reduced (i.e., slow correction to disturbances or transients). 

2) If the amplifier is set up to run in position mode under analog input command, and the 

analog command signal produces too much noise at the motor after tuning, the Analog 

Command Filter or the Velocity Loop Command Filter may be used to reduce the noise 

further.  

10. Tune to multiple sets of profiles representing typical moves that might be executed in the 

application. Starting with Step 6, repeat the process as needed. 

 

Test S-Curve Profile 

If the amplifier will perform S-Curve profile moves, use this procedure to tune the level of 

jerk. (Jerk is the rate of change of acceleration. S-Curve moves reduce jerk to provide a 

smooth profile.) Run an S-Curve profile and adjust velocity, acceleration, deceleration, and 

jerk levels until the desired profile is obtained. For instance: 
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1. On the Profile tab, click the S-Curve button. 

                    

2. Set up an S Curve profile by adjusting the following parameters to represent a typical 

move under normal operation. 

Trajectory Limits Tab 

Maximum Velocity Maximum speed of the profile.  

Maximum 

Acceleration/ 
Deceleration 

Maximum acceleration/deceleration of the profile. The 

deceleration is set to be the same as acceleration. 

Maximum Jerk The value of jerk set during the calculate procedure produces 

an S-Curve whose maximum slope is equal to the trajectory 
profile slope. This value will produce a maximum acceleration 
that is not more than the initial default value of acceleration. 
Small values will produce less jerking but will take longer to 
complete move. Large values will produce more jerking and a 
more trapezoidal profile but will complete the move faster. 

Profile Tab 

Distance Increase the move distance to produce a complete trajectory 
profile. Use an acceptable value the does not exceed 
mechanical limits of the system. 

Move Relative 

Type S-Curve 
  

3. Click Start. 

4. Try multiple sets of profiles representing typical moves that might be executed in 

the application. Starting with Step 2, repeat the process as needed. 
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11.7: Notes on the Position Mode and Position Loop 

Position Loop Diagram 

The amplifier receives position commands from the digital or analog command inputs, over 

the CAN interface or serial bus, or from the CVM Control Program. When using digital or 

analog inputs, the amplifier's internal trajectory generator calculates a trapezoidal motion 

profile based on trajectory limit parameters. When using the CAN bus, serial bus, or CVM 

Control Program, a trapezoidal or S-curve profile can be programmed. The trajectory 

generator updates the calculated profile in real time as position commands are received.  

The output of the generator is an instantaneous position command (limited position). In 

addition, values for the instantaneous profile velocity and acceleration are generated. These 

signals, along with the actual position feedback, are processed by the position loop to 

generate a velocity command. 

To bypass the trajectory generator while in digital or analog position modes, set the maximum 

acceleration to zero. The only limits in effect will now be the velocity loop velocity limit and 

the current limits. (Note that leaving the maximum acceleration set to zero will prevent other 

position modes from operating correctly.) 

 

The following diagram summarizes the position loop. 

 

Trajectory Limits  

In position mode, the trajectory generator applies these limits to generate the profile. 

Limiter Description 

Maximum Velocity Limits the maximum speed of the profile. 

Maximum 
Acceleration 

Limits the maximum acceleration rate of the profile.  

Maximum 
Deceleration 

Limits the maximum deceleration rate of the profile.  

Abort Deceleration Specifies the deceleration rate used by the trajectory generator when 

motion is aborted.  

Position Loop Inputs From the Trajectory Generator 

The position loop receives the following inputs from the trajectory generator. 

Input Description 

Profile Velocity The instantaneous velocity value of the profile. Used to calculate the 
velocity feed forward value. 

Profile Acceleration The instantaneous acceleration/deceleration value of the profile. Used 

to calculate the acceleration feed forward value. 

Limited Position The instantaneous commanded position of the profile. Used with the 

actual position feedback to generate a position error. 

Target

Position
Velocity

Command

Trajectory

Generator

Position Loop

Feedback

Limits:

Max velocity

Max accel

Max decel

Abort decel

Position Proportional Gain (Pp)

Velocity Feed Forw ard (Vff)

Acceleration Feed Forw ard (Aff)
Profile Acceleration

Profile Velocity

Limited Position

+

+

-

+

+

Gain

Multiplier

from motor encoder or resolver

from optional position encoder (on load)
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Position Loop Gains 

The following gains are used by the position loop to calculate the velocity command: 

Gain Description 

Pp -  
Position loop 

proportional 

The loop calculates the position error as the difference between the 
actual and limited position values. This error in turn is multiplied by 

the proportional gain value. The primary effect of this gain is to reduce 
the following error. 

Vff -  

Velocity feed forward 

The value of the profile velocity is multiplied by this value. The primary 

effect of this gain is to decrease following error during constant 
velocity. 

Aff - Acceleration 
feed forward 

The value of the profile acceleration is multiplied by this value. The 
primary effect of this gain is to decrease following error during 

acceleration and deceleration. 

Gain Multiplier The output of the position loop is multiplied by this value before being 
passed to the velocity loop. 

Position Loop Feedback 

Some Copley Controls amplifiers feature dual-sensor position loop feedback, configured as 

follows: 

• Single sensor. Position loop feedback comes from the encoder or resolver on the motor. 

• Dual sensor. Position loop feedback comes from the encoder attached to the load. 

(Note that in either case, velocity loop feedback comes from the motor encoder or resolver. 

Position Loop Output 

The output of the position loop is a velocity command used as the input to the velocity loop. 

Position Wrap 

The position wrap feature causes the position reported by the amplifier to “wrap” back to zero 

at a user-defined value instead of continually increasing. Once set, the reported position will be 

between 0 and n-1 where n is the user entered wrap value. This feature is most useful for rotary 

loads that continually turn in one direction and only the position within a revolution is of interest 

to the user.  

Relative moves with the wrap value set will move the relative distance called for. Example; if 

the wrap value is set to 1000 and a relative move of 2500 is commanded, the axis will turn 2 ½ 

revolutions.  

Absolute moves will move the shortest distance to arrive at the programmed position. This could 

be in the positive or negative direction. Moves programmed to a point greater than the wrap 

value will cause an error.  

 

Following Error Faults  

When the position error reaches the programmed fault threshold, the amplifier immediately 

faults. (The following error fault can be disabled.)  

 

Following Error Warnings 

When the position error reaches the programmed warning threshold, the amplifier immediately 

sets the following error warning bit in the status word. This bit can be read over the CAN network. 

It can also be used to activate a digital output.  
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Position and Velocity Tracking Windows 

When the position error exceeds the programmed tracking window value, a status word bit is 

set. The bit is not reset until the position error remains within the tracking window for the 

programmed tracking time.  

A similar method is used to handle velocity errors. 

 

Following Error Fault Details 

Position Error Reaches Fault Level 

As described earlier, position error is the difference between the limited position output of the 

trajectory generator and the actual position. When position error reaches the programmed 

Following Error Fault level, the amplifier faults (unless the following error fault is disabled.) As 

with a warning, a status bit is set. In addition, the fault is recorded in the error log. See Error 

Log. 

Additional responses and considerations depend on whether the fault is non-latched or latched, 

as described below. 

 

Amplifier Response to Non-Latched Following Error Fault 

When a non-latched following error fault occurs, the amplifier drops into velocity mode and 

applies the Fast Stop Ramp deceleration rate to bring the motor to a halt. The amplifier PWM 

output stage remains enabled, and the amplifier holds the velocity at zero, using the velocity 

loop. 

 

Resuming Operations After a Non-Latched Following Error Fault 

The clearing of a non-latched following error depends on the amplifier’s mode of operation. 

Issuing a new trajectory command over the CAN bus or the ASCII interface will clear the fault 

and return the amplifier to normal operating condition.  

If the amplifier is receiving position commands from the digital or differential inputs, then the 

amplifier must be disabled and then re-enabled using the amplifier’s enable input or though 

software commands. After re-enabling, the amplifier will operate normally. 

 

Amplifier Response to a Latched Following Error Fault 

When a latched following error fault occurs, the amplifier disables the output PWM stage without 

first attempting to apply a deceleration rate.  

 

Resuming Operations After a Latched Following Error Fault 

A latched following error fault can be cleared using the steps used to clear other latched faults: 

• Power-cycle the amplifier 

• Cycle (disable and then enable) an enable input that is configured as  

Enable with Clear Faults or Enable with Reset 

• Access the CME 2 Control Panel and press Clear Faults or Reset 

• Clear the fault over the CANopen network or serial bus 
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11.8: Motor Characterization  
This feature is only available for use with linear motors. 

If motor specification cannot be obtained from the motor manufacturer due to obscolnece or 

lack of good support, then the motor ratings label can be used.   

Motor ratings label            

 
DANGER 

Make sure motor is mounted firmly and verify accuracy and 
completeness of motor data. 

Failure to heed this warning can cause equipment damage, injury, 

or death. 

 

 

 

 STEPPER TUNING 

 

12.1: Stepper Motor Support 
CME supports Copley’s stepper amplifier family. Stepper amplifiers can run in stepper mode or 

servo mode.  

This chapter describes controls that can be used to fine-tune a stepper amplifier in stepper 

mode: Encoder Correction and Detent Compensation Gain. It also describes the screen used in 

stepper mode to set Position Limits.  

When a stepper amplifier is used in servo mode, it operates as a true, closed loop, servo amplifier 

controlling a stepper motor. After putting the stepper amplifier into servo mode, set it up and 

tune it just as you would a servo amplifier.  

 

12.2: Position Limits (Stepper Amplifier) 
Perform the following steps to set position limits for a stepper amplifier connected to an encoder 

with Encoder Correction enabled (not operating in Servo mode). 

  Click the Pos Limits button  on the Main screen. 

         

 

!
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Parameter Description 

Max Velocity Maximum trajectory velocity. Max value may depend upon the back EMF and 

the Max feedback count. Min:0. Default: 0.25 x motor velocity limit. 

Max Accel Maximum trajectory acceleration. Max value may depend upon the load 

inertia and peak current. Min:0. Default: 0.5 x velocity loop Accel. Limit 
value. 

Max Decel Maximum trajectory deceleration. Max value may depend upon the load 

inertia and peak current. Min:0 (disables limit). Default: 0.5 x velocity loop 
Accel. Limit value. 

Abort Decel Deceleration rate used by the trajectory generator when motion is aborted. 

Min:0. Default: 0.5 x velocity loop Accel. Limit value. 

Jerk Rate of change of acceleration. The value of jerk set during the calculate 
procedure produces an S-Curve whose maximum slope is equal to the 
trajectory profile slope. This value will produce a maximum acceleration that 

is not more than the initial default value of acceleration. Small values will 
produce less jerking but will take longer to complete move. Large values will 

produce more jerking and a more trapezoidal profile but will complete the 
move faster. 

Abort Jerk The value of Jerk used when a move is aborted. 

Note that setting limits to zero disables the trajectory generator so that the command input 
is not limited by the generator. Velocity is only limited by the Velocity Limit set in the Velocity 
Loop. 

 

 

12.3: Encoder Correction 
 

For a stepper motor with an encoder, encoder correction may be used to compensate for lost 

microsteps. Normally, in an open loop micro stepping mode with an encoder, the total number 

of micro steps per revolution is set to the number of encoder counts per revolution. However, a 

following error can accumulate when micro steps are lost. 

 

In encoder correction mode, when a commanded position is not equal to the actual position, 

indicated by encoder counts, the following error is multiplied by the Encoder Corrections 

proportional gain (ECp), and micro steps are added to the open loop micro stepping loop. 

 

If the error is large or the gain is high, micro steps are added at a higher rate, up to the Max 

step rate limit. If the ECp gain is too high, the loop will become unstable and corrections will not 

reduce the position error. The position error will not be reduced if the Max step rate is outside 

of the motors stepping ability. If steps are lost during a move, encoder corrections are made 

during the move, but will tend to accumulate during the trajectory profile and become resolved 

by the end of the move. 
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1. Click to open the Encoder Correction  screen. 

 

 

 2. Set the Encoder Correction parameters: 

Parameter Description 

ECp Proportional gain used to compensate for lost microsteps. 
Default: 0. 

Max Step Rate Maximum velocity allowed while using ECp to correct 
position errors. Excessive velocity can result in more lost 
microsteps. Default: 0. 

  

 

 
 
Test Encoder Correction 

 While holding position, introduce a position error by rotating the motor shaft by hand.  

NOTE: Reduce the holding current slightly if unable to rotate shaft. 

The ECp will act on the error and the motor will settle into position slower than a 

servo motor but in a reasonable amount of time. 

 

12.4: Detent Compensation Gain 
Stepper motors are subject to torque detent that can cause undesired velocity fluctuation 

between full steps of motion. The Detent gain feature can compensate for this detent.   

1. Click Detent  to open the stepper amplifier Advanced Tuning screen. 
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Setting Description 

Velocity Tuning velocity. Default: 0. 

Trace Time Length of trace interval to be shown on screen. Default: 25 ms. 

Gain (Detent Gain) The Stepper Detent Gain value. Default: 0. 

Auto Scale Lock When selected, prevents trace display from rescaling during tuning. 

 

2. Click Start to begin the tuning. 

3. Adjust Velocity from 0 until the mechanical system begins to resonate. (Using a 1.8 

degree step motor with 200 full steps, this will typically occur at a velocity of 40-70 

rpm.) 

4. Adjust Gain until the resonance increases, and then back it down until the resonance is 

minimized. 

5. Click Stop to stop the tuning. 

6. Click Close to close the window. 

7. On the CME Main screen, click Save to Flash . 

 

 HOMING 

13.1: Overview 
 

The Homing screen allows homing to be configured and tested.  Changes made to this screen 

get saved to amplifier RAM.  On amplifiers configured for Absolute encoders, calibration can be 

performed. 

 

Click the Home button  on the Main screen to open the Home screen 
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Parameter Description 

Software limits: Positive 
Position of user-defined travel limits that take effect after homing operation.  

Software limits: Negative 

Software limits: Deceleration 
Rate 

Deceleration rate used to stop a motor when approaching a software limit. 

Software limits: Disable Disables the use of software limits by setting both limits to zero. 

Method Homing method. See Homing Method Descriptions 

Direction of Motion Initial direction of motion for the homing method (Pos or Neg). 

Fast Velocity The velocity used to find a limit or home switch. Also used when moving to 
an offset position, or a resolver or Servo Tube index position. 

Slow Velocity The velocity used to find a switch edge, incremental or analog encoder index 
pulse, or hard stop.  

Accel/Decel The acceleration and deceleration rate used during homing. 

Offset Execute a move of this distance after the reference is found. Set actual 
position to 0 and call the new position home. 

Current Limit Hard stop home is reached when the amplifier outputs the homing Current 
Limit continuously for the time specified in the Delay Time. 

Current Delay Time 

Following Warning Shows the programmed following warning level. 

Actual Current Shows actual current being applied to windings during homing. 

Actual Position Shows the actual position of the axis. 

Homing Adjustment Shows the Home offset measured after homing is performed. 

Test without home 
adjustments 

Selecting this option and pressing the Home Button tests the adjusted home 
position without making any changes to the saved home position. The 
resulting homing offset is reported in the Homing Adjustment text field. 

 
Starts the homing sequence using the settings shown on the screen. 

 
Stops the homing sequence. 

 
Starts the Calibration routine for absolute encoders. See Absolute Encoder 

Calibration 

 
Saves the homing parameters to amplifier flash. 

 
Discards unsaved homing parameters, then closes the screen.  The rules for 
discarding unsaved values are as follows: 

• If the Save button was never clicked, all of the homing parameters 
will be reverted to the values at the time that the screen was opened. 

• If the Save button was clicked, then the homing parameters will be 
reverted to the values at the time of the last Save event. 

Upon closing, any home sequence in progress will be aborted. 

 

 

 

 

 

13.2: Absolute Encoder Calibration 
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When absolute encoders are used, the absolute encoder value that corresponds to the zero 

position in the machine’s reference frame is saved to flash memory in the drive. This value is 

then added to the absolute encoder reading so that all position measurements are in absolute 

units in the machine’s coordinate system. Movement of the motor to ‘find’ the machine’s 

reference point is not necessary. This process is called calibration because it’s done once when 

the machine and drive are commissioned together and does not need to be repeated until the 

encoder is changed, or adjustment of the machine-zero location is changed. 

 

Note:  This feature is only available on the Plus family of drives with a minimum firmware version 

of 2.00. 

 

Calibration of an absolute encoder is a two-part process: 

1. Mechanical Homing 

2. Calibration 

 

Mechanical Homing 

 

Mechanical homing is the process of moving the motor to the position that is machine-zero.  This 

is the location from which all dimensions are absolute in the machine’s position reference frame. 

 

 

Calibration 

 

Calibrating the encoder involves saving the absolute position at machine-zero to the drive’s 

flash.  This value will be saved as a negative number and added to the absolute encoder positions 

thereafter by the firmware to convert them to machine absolute values.  This value is stored in 

the Home Offset parameter.  CME 2 provides a single button-click operation to perform this 

calibration. 

Click the Calibrate button  to initiate the calibration routine. 

 

CME will perform the following sequence: 

• Set the calibration bit of the Homing Configuration register. 

• Initiate the homing sequence. 

 

The drive will then perform the following sequence: 

 

• Run the home sequence. 

• Save the Home Offset in flash. 

• Change the home method to Absolute Encoder Immediate Home. 

 

The Homing Adjustment field on the Home screen will show the offset value saved in flash.  Once 

the calibration is complete, the Calibrate button will be disabled until another home sequence is 

run by clicking the Home button.  To remove the calibration, change the Home Method from 

Absolute Encoder Immediate Home to some other method, and run the home sequence.

1. Enter the values of the appropriate homing parameters. 

2. Click the Home button  to run the home sequence. 

3. If necessary, repeat until the motor is positioned at machine zero. 

4. Click the Save button . 
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 CONTROL PANEL 

14.1: Control Panel Overview 
 

 

Click to open the Control Panel . 

 

14.2: Status Indicators and Messages 
 

The Status area includes status indicator lights (described below) and a message box. Any red 

lights indicate that motion will be inhibited. 

 

Indicator States/Description 

Safety 
State of the safety circuit. Enabled or HI/LO disabled. On amplifiers with 
safety circuit. 

Motor Output 
State of the PWM output stage. Red if the output stage is inactive 
(disabled) 

Hardware Enabled 
State of the hardware enable input(s). Red if one or more enable inputs 
are inactive. 

Software Enabled State of the software enable. Red if the amplifier is disabled by software. 

Positive Limit State of the positive limit switch input. Red indicates an activated positive 
limit switch. 

Negative Limit State of the negative limit switch input. Red indicates an activated negative 
limit switch. 

Software Limits State of the software limits. Red indicates an activated software limit. 

Motor Phase Indicates a motor phasing error. Red indicates a motor phasing error 
exists. 

Red if fault
is active

Yellow if warning
is active

Display error log

Message box

Control functions

Status indicators
Monitor real-time amplifier values
and operational  mode

Jog mode controls
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Motion Abort Input State of the programmed Motion Abort Input. Red indicates the input is 
active. 

CVM Control 
Program 

Status of the CVM Control Program. 

Home Indicates whether the axis has successfully been referenced (homed). 

CAN Status Status of the CAN Bus. Yellow indicates CAN warning limit reached. Red 
indicates bus error detected. 

Gain Scheduling Indicates whether Gain Scheduling is active. 

 

Indicates that a fault is active. Check the status message box for a 

description of the most recent fault: .  
Check the Error Log for a full history of faults and warnings. 

 

Indicates that a warning is active. Check the status message box for a 

description of the most recent: .  
Check the Error Log for a full history of faults and warnings. 

Message Box Displays status descriptions.  

 

14.3:  Control Panel Monitor  
 

The Control Panel Monitor displays real-time values of selected variables. 

     

  
 

Monitor Variables 

Actual Current Following Error Passive Load Position 

Actual Motor Velocity Commanded Current Limited Position 

Actual Motor Position Commanded Velocity Analog Command 

Actual Load Velocity Commanded Position Bus Voltage 

Actual Load Position Profile Velocity Amplifier Temperature 

Velocity Error Profile Acceleration Motor Phase Angle 

RMS Current Over Period   

 

Mode: Displays the amplifier’s operating mode in RAM. In camming mode, it also displays the 

active cam table number. 

 

Start Logging: Logs what is currently displayed in the Control Panel Monitor into a CSV file. 

The CSV will be saved to the following location:  

C:\Users\Public\Documents\Copley Motion\CME 2\LogFiles. 
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14.4: Control Functions 
 

The Control area of the screen provides functions related to overall amplifier control. The screen 

options vary with model and configuration. 

   
 

Control Description 

Enable Click to software enable the amplifier. 

Disable Click to software disable the amplifier. This will also stop any CVM 

programs that are running. 

Set Zero Position Click to set the amplifier’s actual position counter to zero. 

Release Brake Press and hold to release the break if the drive is disabled. 

Clear Faults Click to clear all amplifier faults. 

Reset Click to reset the amplifier. 
   

 

 
WARNING 

Risk of unexpected or uncontrolled motion. 

Using the CME, Set Zero Position function while the amplifier is 

operating under external control could cause unexpected or 

uncontrolled motion.  

Failure to heed this warning can cause equipment 
damage. 

 

14.5: Jog Mode 
 

Jog mode provides a simple means for moving/jogging the motor. 

 

         

 1. To put the amplifier in jog mode, select Enable Jog. 

 2. Set up a jog move by setting the following mode-specific parameters: 

Mode Parameter Description 

Current Current Current applied to the motor. Limited by current loop 

Continuous Current.  

!
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Warning: Unloaded motors may, depending on 

torque setting, ramp up in speed very quickly. 

Velocity  Jog Speed Velocity of the jog move. Limited by velocity loop Vel. 

Limit. 

Position  Velocity Velocity of the jog move. Limited by velocity loop Vel. 

Limit. 

Acceleration Acceleration limit of the jog move. 

Deceleration Deceleration limit of the jog move. 
 

  

 3.   Command the move: 

Mode Steps 

Current • Hold Pos to apply positive current to the motor or hold down Neg 

to apply negative current to the motor.  

• Release the button to command zero current. 

Velocity • Hold Jog Pos to command a forward velocity or hold down Jog 

Neg to command a negative velocity.  

• Release the button to command zero velocity. 

Position • Hold Move Pos to generate a forward move profile or hold Move 

Neg to generate a negative move profile.  

• Release the button to stop movement.  

NOTE: Position mode jog is accomplished by continuously updating 

the commanded position. If a following error develops with 

Following Error Fault disabled, motion will not stop on button 

release. Instead, it stops when actual position = commanded 

position. 
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 SCOPE 

15.1: Overview 
 
The Scope can be used to tune the amplifier, monitor performance, and perform diagnostics. 

Function Generator and Profile Generator can drive the motor without external control. Auto Set 

Up feature sets typical initial values for scope parameters.  

 

        
 

15.2: Menu, Display and Controls 

File Menu 

 

      
 

The File menu contains the options to save/restore scope settings.  This feature is useful for 

saving custom settings used for tests that are run frequently.  

 

File Menu 
Save Settings Saves current scope settings to a file 

Restore Settings Restores settings from a file 
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Display 

 

To access the Trace Display menu, Right-click in the trace display area 

 

 
 

 
Menu Parameter Description 

Line Style line A line connects the plotted data points. 

plus The Scope plots data points as plus signs, with no connecting line. 

connected plus Data points are plotted as plus signs and are connected with a line. 

Preferences anti-aliasing When anti-aliasing is selected, the Scope removes screen-related 
jaggedness in the displayed trace. Use of this feature may slow down 
the refreshing of traces on slow computers. 

grid When selected a grid is displayed on the scope screen. 
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Trace Display Zoom 

 

1. Hold the left mouse button down while dragging a box around the area of interest. 

 

  

2. Release the button to let the display zoom in on the selected area. 

      

  

3. To restore the normal zoom level immediately, left-click anywhere on the trace. 

(Normal zoom level is also restored when the next trigger event occurs.) 

Controls 

 

    
 

Action Description 

 
Save a trace. See Scope Trace Files 

 
Begins recording a trace 

 
Stops recording a trace 

 
Clears the trace from the screen and trace data from buffer 

 

 



CME User Guide   

126 Copley Controls 

      
 

Function Description 

Auto Setup When selected, the scope will be set up based on the setting for either the Function 
or Profile Generator (whichever is active). 

Single Trace When selected only one trace will be collected and displayed, otherwise a new 
trace will be started as soon as the current trace is displayed. 

Auto Scale Lock When displaying the trace data, the scope will automatically scale the vertical axis 
for optimal viewing.  When Auto Scale Lock is selected, the y-axis scale will be 
locked at is current setting.   

Trace Time This is the total amount of time the trace is recorded. 

Sample Rate The rate at which each sample is collected.  When tracing multiple channels, all 
channels are collected at approximately the same time. 

 

15.3: Function Generator 
 

The Function generators can provide inputs to the different control loops for tuning and 

diagnostics purposes without using an external control source.  

 

      
 

The Start button starts the function or profile generator. The Stop button stops the generator 

and aborts any profiles in progress. 

 

Parameter Description 

Apply To Control loop to which the Excitation will be applied: Current (available in all modes), 

Velocity (available in velocity or position mode), or Position (available in position mode 
only). 

Function Function that will be applied to the control loop selected in the Apply To list box. The 

choices vary with the control loop selected: 

Selected Control 

Loop 

Functions Available 

Current Sine Wave, Square Wave, Step Forward, Step Forward and 
Reverse, and Impulse 
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Velocity Sine Wave, Square Wave, Step Forward, Step Forward and 

Reverse 

Position Sine Wave, Square Wave 
 

Amplitude Amplitude of the command. Units vary depending on the value chosen in the  

Apply To field. 

Frequency (Sine Wave and Square Wave only.) Frequency of input command cycle. 

Period (Step Forward, Step Forward and Reverse, and Impulse only.) Duration of each input 
pulse.  

 

 

15.4: Profile Generator 
 

     
 

 

Parameter Description 

Move Relative: Moves axis a specified distance from the starting position. 

Absolute: Moves axis to a specific position. 

Type Trap or S-Curve. 

Distance Distance for Relative move. 

Position Target position for Absolute move. 

Reverse and Repeat (Relative move only.) When selected, will continuously generate forward and 
reverse moves of the distance specified until Stop is pressed. 

15.5:  Trace Channel Variables 
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  Click the Channel button to open the Trace Variable selection screen 

 

     
 

       
 

Category Trace Variable 

Disabled <Channel disabled, no associated variable> 

Current Commanded Current, Actual Current, Limited Current, I2T Amplifier Accumulator,  
I2T Motor Accumulator. 

Velocity Profile Velocity, Commanded Velocity, Limited Velocity, Actual Motor Velocity, Actual 
Load Velocity, Unfiltered Motor Velocity, Velocity Error 

Position Commanded Position, Limited Position, Actual Load Position, Actual Motor Position, 

Following Error, Passive Load Position 

Acceleration Profile Acceleration 

Voltage Analog Command, Bus Voltage, Analog sin Input, Analog cos Input, Terminal Voltage 
Stepper, Terminal Voltage Servo 

Miscellaneous Motor Phase Angle, Amplifier Temperature, Hall States 

Digital Inputs Digital input line states 

Digital Outputs Digital output line states 

Event Status 
Faults 
 

Short Circuit, Amp Over Temperature, Over Voltage, Under Voltage, Motor Over 
Temperature, Feedback Error, Motor Phasing Error, Following Error, Command Input 
Fault, Amplifier Fault (a latched fault is active).  

Event Status 
Warnings 
 

Current Limited, Voltage Limited, Positive Limit Switch, Negative Limit Switch, 
Following Warning, Velocity Limited, Acceleration Limited, Positive Software Limit, 
Negative Software Limit, Pos Outside of Tracking Window, Vel Outside of Tracking 

Window.  

Event Status 
Misc. 
 

Amp Disabled by Hardware, Amp Disabled by Software, Attempting to Stop Motor, 
Motor Brake Active, PWM Outputs Disabled, Position Has Wrapped, Home Switch 
Active, In Motion, Phase Not Initialized.  

Raw Encoder 
Signals 

Primary Encoder A, Primary Encoder B, Primary Encoder X, Primary Encoder S, 
Secondary Encoder A, Secondary Encoder B, Secondary Encoder X, Secondary 
Encoder S 
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15.6: Trigger Setup  
 

  Click the Trigger Setup button  to open the Trigger Settings screen. 

     
 

Setting Description 

Trigger Type Type Condition 

Immediate Trigger Trigger as soon as a trace is started (when the Record 
button is pressed). 

Rising Edge Trigger when the selected channel's input changes from 

below to above the trigger level. 

Falling Edge Trigger when the selected channel's input changes from 
above to below the trigger level 

Above Level Trigger as soon as the selected channel's input is greater 

than or equal to the trigger level. 

Below Level Trigger as soon as the selected channel's input is less than 
or equal to the trigger level. 

Function Generator Trigger on the start of the next function generator cycle. 

Input Level High/Lo Trigger when specified input is high or low 

Output 
Active/Inactive 

Trigger when specified output is active/inactive 

Event Status Rising 

Edge/Falling Edge 

Trigger on the rising or falling edge of an event status bit. 

Raw Encoder Signal 
Level H/Lo 

Triggers when the raw encoder signal is Hi/Lo 

Trigger On Selects which channel will be used as the trigger source. 

Position Selects placement of the trigger event on the screen. (Value is not configurable for 
Immediate or Function Generator trigger types.). 

• Left for optimal viewing of events following the trigger. 

• Middle for optimal viewing of events preceding and following the trigger. 

• Right for optimal viewing of events preceding the trigger. 

Level Sets the trigger level, in units appropriate to the channel selected. 

Event Status Bit With an event status trigger type selected, choose the status bit that will trigger 
the trace. For descriptions of the event status word. 
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15.7: Measurement Tab 
The Measurement tab allows you to measure and analyze data from up to three parameters 

during an interval defined by adjustable cursors. The Cursor Data area displays a parameter’s 

values at the left and right cursor locations, and the difference between the two values (Delta). 

The Analysis area displays the minimum, maximum, average, and root mean square of the 

parameters during the cursor period. 

 

                                 

 
 

When Show Cursors is not set, the Cursor Data fields are inactive and the Analysis fields show 

calculations based on data from the entire trace cycle.  

 

1. To display cursors and activate the Cursor Data fields, set Show Cursors

. 

2. To move a cursor, click on the cursor and hold the left button while dragging the 

cursor to the desired location. Release the left button to place the cursor in the new 

location.  

3. To select a parameter to measure and analyze within the cursors, choose a channel in 

one of the three channel lists on the Measurement tab: 

 

 

  

Cursors 
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15.8: Control Loop Parameters 
 

The Oscilloscope provides convenient access to all the control loop parameters that might be 

used in tuning and diagnosing an amplifier. The user can adjust these parameters and see the 

results immediately on the scope. Control loop parameters are accessed through a set of tabs, 

shown below. 

     
 

Note that the parameters represented on these tabs can also be accessed through the screens 

used to configure the control loops and the digital position input. Changing a value in the Scope 

tool automatically updates the value on the other screens where it appears, and vice versa. 

Control loop parameter tab descriptions follow. 

Gains Tab 

 
Modes Gains Description For More Information 

Position mode only 

Pp Position loop proportional gain.  

Position Loop Gains Aff Acceleration feed forward.  

Vff Velocity feed forward. 

Position or velocity 
mode only 

Vp Velocity loop proportional gain.  
Velocity Loop Gains 

Vi Velocity loop integral gain. 

All modes 

Cp Current loop proportional gain. 
Current Loop Gains 

Ci Current loop integral gain.  

ECp Encoder Correction Gain (Stepper only) Encoder Correction 

Trajectory Limits Tab 

 

Available in position mode. 

  
For more information see Position Loop Setup and Tuning 
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Position Loop Parameters 

 

Available in position mode. 

  
Set Zero Position sets the amplifier’s actual position count to zero. For more information, see 

Position Loop Setup and Tuning. 

 

Velocity Loop Parameters 

 

Available in position and velocity modes. 

 
For information see Velocity Loop Setup and Tuning. 

 

15.9:  Scope Trace Files 
 

The Oscilloscope can save trace data to disk that can be opened later with the Trace Viewer. 

When the save trace data to disk operation is performed, CME 2 saves the data in three different 

files: 

• .sco: This is a CME 2 format which contains scope settings and trace data 

• .csv: This is a standard comma-separated value file format that can be imported into 

spreadsheet software like Microsoft Excel. 

• .txt: This is a tab-separated value file similar to the .csv file.  This is intended to be 

imported by software that can only read tab-separated values. 

The format of the .csv and the .txt files are identical except for the separator: 

• Column 1: time 

• Column 2: Trace Channel 1 data 

• Column 3: Trace Channel 2 data (if used) 
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• Column n: Trace Channel n data (if used) 

The trace data is in amplifier units, not user units (see Parameter Dictionary for units). 

15.10: Trace Viewer 
 

The Trace Viewer screen displays the contents of .sco files.  All of the trace display features 

(zooming, line style, etc.) as well as the measurement functions are available in this 

screen. 

 

1. On the Main screen, choose Tools→View Scope Files to open the window.  
2. Click Open File. When prompted, select the name of the file you wish to open. Then, 

click Open to display the file in the Trace Viewer window. 

 

                 

 FILTERS 

 

16.1: Setting Parameters 
To change or view filter configurations follow these steps: 

1. Choose the Configure Filters button  from the main screen to open the 

Filter Configuration screen. 

2. To view present filter settings choose the Filter Settings tab. Choose other tabs to 

configure Analog, V Loop, I Loop or Input Shaping settings. 
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16.2: Filter Configuration Windows 
Along with the location of a cut-off frequency on the filter curve, there are several filter 

configuration parameters available depending on the initial choice of: Standard Filter 

Types and Standard Filter Families.  

Filter configuration choices may include: 

• Number of Poles (the location of a cut-off frequency on the filter curve) 

• Cut Off Frequency 

• Frequency 2 (If two poles are chosen) 

• Pass Band Ripple 

• Stop Band Ripple 

 

16.3: Filter Settings 
The Filter Settings tab opens a window that shows what filters have been selected. 

 

 
16.4: Input Shaping 
Input shaping is a method by which unwanted command induced vibrations are kept to a 

minimum by damping them with superimposed impulses. This produces a command that will 

drive the system with limited residual vibration. 

In order to set the input shaping parameters, first measure the mechanical frequency; see 

Measuring Mechanical Vibration. 

 

Below is a diagram of the input shaping process. 
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Below is a sensitivity curve. When F = Fm, there is zero vibration. 

 

 
 

Analog 

The Analog tab opens a window that shows analog filter choices and a representative 

curve. Modify the settings as needed and press Apply. 
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Velocity Loop 

The V Loop tab opens a window that shows Velocity Loop filter choices and a 

representative curve. Modify the settings as needed and press Apply. Selecting Default 

will supply a 200 Hz Low Pass filter to the first velocity loop output filter. 

 

    

Current Loop 

The I Loop tab opens a window that shows Current Loop filter choices and a 

representative curve. Modify the settings as needed and press Apply. 
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16.5: Standard Filter Types 

Low Pass Filter 

Frequencies below the selectable cut-off are allowed to pass. 

Example: 

 
 

High Pass Filter 

Frequencies above the selectable cut-off are allowed to pass. 

Example: 

 

Notch Filter  

Notch filters allow a bandstop in a range between two selectable frequencies. It may be 

Butterworth (no ripple), Chebyshev (selectable passband ripple), or elliptical (ripple on both 

passband and bandstop). 

Example: 

 
 

 

 

Band Pass Filter 

Band pass filters allow a range of frequencies, between two selectable cut-offs, to pass. It may 

be Butterworth, Chebyshev, or Elliptical. 
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Custom Biquad Filter  

The Bi-Quadratic filter has two quadratic terms: one in the numerator, and one in the 

denominator. The numerator affects the filter’s two zeros and the denominator affects the filter’s 

two poles. Many filter classes and types can be expressed in the Bi-Quad form by entering the 

coefficients. The coefficients can be calculated using any commercially available math software 

package and entered as floating-point numbers. However, due to the fixed-point representation, 

the numbers may be rounded. 

Example: 

 

16.6:  Standard Filter Families 

Butterworth Filter  

A Butterworth filter has two poles for faster roll-off at the cut-off frequency. 

Example: 

 
 

Chebychev Filter  

A Chebyshev filter has a faster roll-off than a Butterworth filter, but, as a result of the fast roll-

off, ripple is introduced into the passband frequency. 

Example: 

 
 

Elliptic Filter  

Similar to a Chebyshev filter but ripple is introduced into both the passband and the stopband. 

It has a faster roll-off than a Chebyshev filter. 

Example: 
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16.7:  Input Shaping Window 
The Input Shaping tab opens a window that shows Input Shaping choices and a representative 

Time and Amplitude table. Modify the settings as needed and press Apply. 

Type as well as Frequency and Damping Rate may be adjusted. Overcurrent is adjustable when 

a Negative Zero Vibration or a Negative Zero Vibration and Derivative filter is chosen. If Custom 

is chosen as the Type, Time and Amplitude may be set manually.  

 

      
 

Input Shaping Types 

 

Type Description 

Zero Vibration Single step inputs are replaced with two step inputs of smaller magnitude. 

One of which is delayed by one-half the period of vibration. Sensitive to 
some modeling errors. 

Zero Vibration and 

Derivative 

A zero derivative (of the vibration) constraint is added to Zero Vibration 

impulse shaping, thereby reducing modeling errors. 

Negative Zero Vibration Faster than positive input shaping (Zero Vibration, and Zero Vibration and 

Derivative), but may magnify high frequency vibrations. 

Negative Zero Vibration 
and Derivative 

A zero derivative (of the vibration) constraint is added to Negative Zero 
Vibration impulse shaping. 

Custom Time and Amplitude can be set manually. 
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16.8: Measuring Mechanical Vibration 
There are several ways to measure mechanical vibration. Two choices are offered below. 

 

Using an Accelerometer with CME  

Begin with a Copley drive operational and controlled by CME . 

1. Connect the accelerometer analog output to Copley drive’s Analog + and - on the signal input 

as in the diagram below.  

 

 

2. On CME , click the Scope Tool  . 

3. Select the Measurement tab, choose a channel, select Voltage, then Analog Command. 

4. Perform a move. 

5. After the move is complete, measure Tm (1/Fm), which is the period of mechanical 

oscillation. 

 

 

Using CME to Monitor Following Error 

 

Monitor the following error using CME ’s scope option. 

Begin with a Copley drive operational and controlled by CME . 

1. On CME, click the Scope Tool  . 

2. Select the Measurement tab, choose a channel, select Position, then Following 

Error. 

3. Perform a move. 

4. After the move is complete, measure Tm (1/Fm), which is the period of mechanical 

oscillation. 
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 FREQUENCY ANALYSIS 

 

17.1: Overview 
 

The Frequency Analysis screen expands on the functionality of CME2 by providing a tool to 
measure the frequency response of a system while running a sine sweep.  This further enhances 
the ability to tune and troubleshoot systems, particularly when there is a mechanical resonance 
present. The frequency analysis tool will measure and plot the current/velocity loop frequency 
response on a semi-log graph.  

 

Click    to open the Frequency Analysis screen. 
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17.2: User Interface 
 

Graph 

 

The frequency response data is plotted on a semi-log graph when the sign sweep completes.  

Each time a sine sweep is run, the data is plotted on a graph in a new tab.  The tabs are 

named with the plot number (Plot 1, Plot 2, etc.).  For multi-axis drives, the axis letter is 

appended to the tab name (e.g. Plot 1A, Plot 2B, etc.).  The magnitude scale is displayed on 

the left Y axis and the phase shift scale is displayed on the right Y axis.   

 

  
 

 

Graph Options Menu 

 

To display the plot options menu, right-click anywhere on the graph. 

 

 
 

Menu  Menu Items Description 

Line Style line A line connects the plotted data points. 

plus The Scope plots data points as plus signs, with no connecting line. 

connected plus Data points are plotted as plus signs and relate to a line. 

Preferences anti-aliasing When anti-aliasing is selected, the Scope removes screen-related 
jaggedness in the displayed trace. Use of this feature may slow 
down the refreshing of traces on slow computers. 

grid When selected a grid is displayed on the scope screen. 
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Sine Sweep Controls 

 

  
 

Mode 

Description: Mode in which the Sine wave will operate in.  Options are closed and 

open loop position, current, and velocity. 

Units: None 

Default:  Current 

 

Amplitude 

Description: The amplitude of the sine wave. 

Units: A (current), rpm (velocity, rotary motor), mm/s (velocity, linear motor). 

Default:  Current: 10% of the current loop continuous current. 

Velocity: 5% of the velocity loop velocity limit. 

 

Start Frequency 

Description: The first frequency of the sine sweep. 

Range: 0.1 to 9999 Hz  

Units: Hz 

Default:  Current: 10 Hz,  

Velocity: 5 Hz 

 

End Frequency 

Description: The last frequency of the sine sweep. 

Range: 0.2 to 10000 Hz  

Units: Hz 

Default:  Current:  3000 Hz 

Velocity:  250 Hz 

 



CME User Guide   

144 Copley Controls 

Number of Samples 

Description: The number of sine wave frequencies to run during the sine sweep.  The 

frequencies are calculated so that there are an equal number of 

frequencies per decade. 

Range: 2 to 100 

Units: None 

Default:  50 

 

Current Loop Offset 

 Description: Applies an offset to the current loop. 

 Range: +/- continuous current 

 Units: Amps 

 Default: 0 

 

Start 

Description: Starts the sine sweep. 

Units: N/A 

Default:  N/A 

 

Stop 

Description: Cancels the sine sweep in progress. 

Units: N/A 

Default:  N/A 

 

Log Text Window 

 

The log text window shows the progress of the sine sweep.  For each frequency, the measured 

frequency response (magnitude and phase shift) is displayed.  These are the values that get 

plotted in the graph. 
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Measurement 

 

The Measurement tab contains tools to analyze the data displayed on the graph. 

 

Cursors 

Select   to display the cursors on the graph. 

 

 
 

 

To move the cursors, left-click a cursor and drag it to the left or right.  As the cursor is moved 

along the plot, the values for Frequency, Magnitude, and Phase Shift are updated in the 

Measurement tab. 
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Show -3db Line 

 

Select   to display a horizontal dashed line where the magnitude is -3db.  The -3db 

point on the magnitude plot is used to determine the bandwidth of the system. 

 

 
 

 

 

Show -180 degree Line 

 

Select   to display a horizontal dashed line where the phase shift is -180 degrees.  

This line is useful for determining the phase and gain margins of your system. 

 

 
 

 

File Menu 

 

 
 

File Menu Items Description 

Save Current Plot Saves the data from the sine sweep of the plot currently displayed in a csv 
format that can be imported to other software such as spreadsheets or 
mathematical analysis programs. 

Restore Plot from File Allows for opening a Plot from a previous save file. 
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Filter Screen 

 

Click  to open the Filter Configuration screen. 

 

Status Bar 

 

The left and middle text fields of the Status Bar show various faults and warnings while the 

Frequency Analysis screen is open. 

 

Faults/Warnings Status 

 

The left text field of the status bar shows the faults and warnings.  Faults will be displayed 

with a red background and warnings will be displayed with a yellow background.   Only two 

warnings are monitored during frequency analysis: Current Limited Warning and Voltage 

Limited Warning.  All faults are monitored during frequency analysis. 

 

 
 

 
 

 

Motion Inhibited Status 

 

The middle text field of the status bar shows the conditions that will prevent motion.  The 

conditions that are not faults, but will prevent motion are: 

• Positive and negative software limits 

• Positive and negative limit switches 

• Drive is disabled by hardware (enable input not active). 

• Phase not initialized (only applies when feedback is set up for phase initialization). 

 

 
 

 

 

 DATA, FIRMWARE, AND LOGS 

18.1: Amplifier RAM and Flash Memory 
 

Amplifier RAM 

• Volatile. Contents erased when amplifier is reset or powered off. 

• Initial contents read from flash on power-up. Contents then updated in real time to reflect 

certain operational conditions and changes entered with CME software. At any time, the 

user can use CME to restore data from flash into amplifier RAM. 

 

Flash 

• Non-volatile. Contents retained when the amplifier is reset or powered off. 

• Modified only by using a Save to Flash tool or by closing certain screens (Motor, Setup, 

Homing, or CAN Configuration), whose contents are automatically saved to flash upon 

closing of the screen. 
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Parameters reside in RAM only, Flash only, or both RAM and Flash.  The table below illustrates 

the typical parameter locations.  Refer to the Parameter Dictionary for information about specific 

parameters. 

 

Data Resides In Data 

Flash only This category includes all Motor/Feedback screen data and Setup screen 

(motor/feedback data only). This data is saved to flash when the user 
confirms the values and closes the screens without cancelling. 

Amplifier RAM only Includes operating status data such as actual position, actual current, and 

amplifier temperature. Such data is never stored in flash. It is destroyed 
from amplifier RAM with each power-down or amplifier reset. 

Flash and amplifier RAM Includes all other data not represented in the two categories above. When 

changing these parameters in CME, the value is saved to amplifier RAM only.  
To save these values to flash, the Save To Flash operation must be performed 
or data will be lost on power down or reset. 

 

 

18.2: Data Management Tools 

Amplifier 

Operations performed using the amplifier data management tools at the top of the Main screen 

(shown below) affect amplifier settings, including motor/feedback data. (CVM Control Program 

data is not saved by these operations). 

 

    
 

 

Action Name Description 

    
Save amplifier 
data to disk 

Saves both amplifier and motor/feedback data to a disk with a .ccx 
filename extension.  

    

Restore amplifier 
data from disk 

Restores amplifier and motor/feedback data from a .ccx file to the 
amplifier’s RAM, or flash for the flash only variables.  See Parameter 
Dictionary for parameter descriptions. 

A To Flash operation should be performed to insure that all data is saved 
to flash 

   

Save amplifier 

data to flash 

Saves contents of amplifier RAM to amplifier flash memory.  

   
Restore amplifier 
data from flash 

Restores contents of amplifier flash memory to amplifier RAM. 

 

 

 

 

 

Data Management Tools 
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Motor/Feedback Screen 

 

Operations performed using the Motor screen data management tools only apply to the motor 

parameters.  

         
 

Action Name Description 

   
Save motor data to 
disk 

Saves only motor data to disk with a .ccm filename extension. Amplifier 
data that is not represented on the Motor screen is not saved in this file. 

   

Restore motor data 
from disk 

Restores only motor data from a disk file with a .ccm filename extension 
amplifier flash (the motor parameters are flash only). 

   

Save motor data to 

flash 

Saves the contents of the Motor screen from to amplifier flash memory. 

Amplifier data that is not represented on the Motor screen is not saved. 

Can be used to assure that all changes are saved to flash without closing 
the Motor screen. 

   
Restore motor data 
from flash 

Restores only motor data from amplifier flash memory to the PC. 

Amplifier data that is not represented on the Motor screen is not 
affected. Can be used before closing the Motor data screen to restore 
settings to the previously saved values.  

 

18.3: Multi-Axis Data Tools 
 

The descriptions in this section only apply to multi-axis drives (XE2, BE2, etc.). 

Copy Axis 

 

CME allows one axis to be copied to another.  This feature allows quick set up of multiple axes, 

since only one axis needs to be set up.  The Copy Axis operation copies all RAM/Flash and Flash 

Only parameters to the other axis. 

 

From the menu on the Main screen, select File→Copy Axis.  This will display the Copy Axis 

screen: 

 

    
 

Select the source and destination axes, then click OK.  Note that Copy to Flash is selected by 

default.  If this option is not selected, then the RAM/Flash parameters will only be copied to the 

destination axis’ RAM, while still copying the Flash Only data to the destination axis’ Flash. 

 

Motor data 

management tools 
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Save/Restore Single Axis 

 

CME allows a single axis of data to be saved/restored on a multi-axis drive.  This feature is useful 

when one axis of tuning/setup data is common across many multi-axis drives, but only on one 

axis.  The file will be saved as a .ccx file.  Restoring a .ccx file to a single axis, the file must be 

written as a single axis, otherwise an error will be displayed. 

   

From the menu on the Main screen, select File→Save As→Single Axis.  This will display the 

Save Single Axis screen.  Select the axis to be saved, click OK, and then continue with naming 

and saving the file. 

 

    
 

 

From the menu on the Main screen, select File→Save As→Single Axis.  This will display the 

Restore Single Axis screen.  Select the axis to restore the file data to, click OK, then browse to 

the single axis file. 

 

    
 

 

18.4:  Drive Configuration 
 

The Plus Family of drives have the capability of saving/restoring the entire drive configuration 

to a file.  The drive configuration consists of all parameters (RAM/Flash and Flash Only) and the 

entire contents of the CVM flash, which includes any CVM programs, cam tables, and gain 

scheduling tables.  The file is saved with a .ccd file extension. 

 

This feature is useful to clone drives in one step rather than separately loading each file (.ccx, 

.ccp, .cct, .ccg).  Additionally, the file is in XML format which can be read by some EtherCAT 

masters as an ESI file for File over EtherCAT (FOE). 
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Save Drive Configuration 

 

From the menu on the Main screen, select File→Save Drive Configuration, then choose a 

filename.  A progress bar will be displayed while the data is being saved to the file. 

 

  
 

Restore Drive Configuration 

 

From the menu on the Main screen, select File→Restore Drive Configuration, then choose a 

filename.  A progress bar will be displayed while the data is being saved to the file 

 

 
 

All the data read from the file is saved to the drive’s Flash.  After all of the data is written, the 

drive will be reset, so that the Flash data is copied to RAM. 

 

18.5: Copy Drive Data 
 

In product families prior to the Plus Family, the Drive Configuration feature is not available. To 

clone one drive to the next, multiple steps are required. 

1. Load the .ccx file: 

From the Main screen, click Restore → Amplifier Data. 

OR   Starting from the Setup screen, click Load ccx File . 

       When prompted browse to the folder containing the .ccx file and open it. 

On the Main screen, click Save to Flash  to save the new settings to flash memory. 

  

2.  Load a CVM program .ccp file: 

     From the menu on the Main screen, choose File→Restore→CVM Control Program.  

     When prompted, navigate to the folder containing the appropriate .ccp file and open it. 

This procedure also results in setting the Enable Control Program on Startup option, 

which configures the program to auto start when the amplifier is powered up or reset. 

3.  Load Cam Table .cct files: 

     From the menu on the Main screen, choose File→Restore→Cam Tables.  

     When prompted, navigate to the folder containing the appropriate .cct file and open it. 
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4.  Load Gains Scheduling Table .ccg files 

     From the menu on the Main screen, choose File→Restore→Gains Scheduling Tables.  

     When prompted, navigate to the folder containing the appropriate .ccg file and open it. 

  

TIP:  When copying amplifier data to multiple amplifiers in a production environment, consider 

locking CME to prevent accidental changes to settings.  See Lock/Unlock CME. 

 

18.6: Save MACRO File for Delta Tau Controllers 
 

This feature is available only on Copley MACRO drives such as the XML Xenus MACRO 

 

1. On the CME Main screen, choose File→Save MACRO File to open the MACRO File Save 

window: 

 

2. Enter the ID of the MACRO node with the settings you want to save and click OK. 

3. When prompted, enter a File Name. If needed, navigate from the default AmpData folder 

to another folder where you wish to store the file. 

4. Click Save to save the .pmc file in the same folder and close the screen. 

 

18.7: Lock/Unlock CME 
 

The Lock feature of CME is used to lock out most screens to prevent data from being changed.   

 

WHEN CME IS LOCKED:  

• User cannot change any amplifier or motor settings.  

• User can download amplifier and motor files and Cam Tables, jog the motor, run scope 

functions and profiles, and monitor amplifier performance with the scope and control 

panel. 

 

1. On the Main screen choose Tools→CME Lock/Unlock.  

2. Set a new password in the Password and Verify Password fields. 
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3. Click OK to lock out amplifier setting controls. 

          
 

4. To unlock, choose Tools→CME Lock/Unlock. 

               

Enter the password. Click OK 

 

18.8: Firmware Download 
The amplifier’s flash memory holds the amplifier’s firmware. As needed, perform the following 

steps to obtain new firmware and download it to amplifier flash memory. 

 

NOTES: 

• CME does not support downloading firmware to a node amplifier via a multi-drop gateway 

amplifier; a direct connection (serial, CAN, EtherCAT) must be used.  

• To check the firmware version currently loaded, click the Amplifier Properties button 

or choose Help→About. 
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WARNING: Do not power down or disconnect the amplifier during firmware download. 

 

On the Main screen choose Tools→Download Firmware to open the Download 

Firmware window.  Browse to where the firmware file is located and click Open to 

start the download.  The progress will be displayed while downloading. 

                  

 

When the progress dialog closes, the firmware download is complete. 
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18.9: Error Log 
 

Click the Error Log tool  on the Main screen 

 

     
 

 
Tab Contents 

Active Type and description of each active fault and warning. The contents of this tab are 
automatically refreshed as new events occur. 

History Type, description, and time of occurrence of each fault and most warnings since the 
log was last cleared. The contents of this tab are not refreshed automatically as new 

events occur. The contents are refreshed only when the tab is displayed or when 
Refresh is clicked.  

Frequency Type, description, and frequency of each fault and warning that has occurred since 
the log was last cleared. The contents are refreshed only when the tab is displayed 
or when Refresh is clicked. 

Network 
Status 

(Under CAN control only.) Status of CANopen network. Lists warnings and errors. 

Encoder 

Status 

Reads the encoder status  

 

 

   
Saves the contents of the History and Frequency tabs to a text file. 

 
Clears all History and Frequency entries in the drive. 

 

 
Updates the contents of the History or Frequency tabs. 
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18.10: Communications Log 
 

The communications log displays all communications between CME and the amplifier.  The data 

is only stored in the PC’s RAM by CME; it is not part of the amplifier’s data. 

 

On the Main screen, choose Tools→Communications Log 

       

 

Option Description 

Enable Logging When selected, logging is enabled and all communications, with the 
exception of status messages, are recorded in the log 

Enable Event 
Status Logging 

When selected, status messages are included in the log. Note that 
Show “Get Variable” Cmnds must also be checked to log Event 

Status commands. 

Show “Get 
Variable” Cmds 

When selected, “Get Variable” commands are added to the log. 

 
Saves the contents of the Communications Log to a text file. 

 Clears the log contents from the PC’s RAM 
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 VIRTUAL AMPLIFIER 

 

19.1: Overview 
 

Virtual amplifiers can be used for creating amplifier and motor data files off line.  A new virtual 

amplifier can be created based on a virtual amplifier template file (.ccv) or from an existing .ccx 

file. CME includes a set of .ccv files for each model that is supported. 

            
 

Select the Virtual Amplifier node from the Copley Neighborhood.  This will display the Open 

Virtual Amplifier screen: 

 

      

 Create new amplifier file 

• Select Create new amplifier and click OK. 

• When prompted, select the .ccv that represents the appropriate drive model.  

• Click Open.  The Setup screen will be displayed. 

• Motor and amplifier values may now be viewed, entered, and adjusted. 

 

 Open existing amplifier file 

• Select Open existing amplifier file and click OK. 

• When prompted, select the appropriate .ccx file.  

• Click Open. 

• Motor and amplifier values may now be viewed, entered, and adjusted. 
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 GAIN SCHEDULING 

 

20.1: Overview 
 

The Gains Scheduling feature allows you to schedule gain adjustments based on changes to a 

key parameter. For instance, Pp, Vp, Vi, and Current Offset (A) could be adjusted based on 

changes to commanded velocity.  

 

Gain adjustments are specified in a Gain Scheduling Table. Each table row contains a key 

parameter value and the corresponding gain settings. The amplifier uses linear interpolation to 

make smooth gain adjustments between the programmed settings. 

 

For information on setting up Gains Scheduling refer to AN142: Gain Scheduling app-note. 

http://www.copleycontrols.com/wp-content/uploads/2020/12/AN142-GainScheduling.pdf 

 

 

 

 

 REGEN RESISTOR CONFIGURATION 

 

 

WARNING 

Incorrect values may damage amplifier or external regen 

resistor. 

For the regen I2T algorithms to work correctly, the values entered in 

the following steps must be correct. Damage to the external regen 

resistor may result from incorrect values entered. Damage to the 

amplifier may result if an incorrect resistance value is entered. 

Failure to heed this warning can cause equipment damage. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

!

http://www.copleycontrols.com/wp-content/uploads/2020/12/AN142-GainScheduling.pdf


CME User Guide   

159 Copley Controls 

21.1: Configure a Standard Copley Controls Regen Resistor 
 

1. Click Configure Regen  to open the Regen Resistor screen. 

 

                

 

2. Select the model number XTL-RA-03 or XTL-RA-04 and click OK to save the configuration 

and close the screen.  

       

 
 

21.2: Configure a Custom Regen Resistor 

1. Click Configure Regen  to open the Regen Resistor screen. 
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2. Select Custom Resistor and click Configure to enter the custom resistor data. Read the 

information displayed and click OK. 

        

 

3. Follow the instructions on step 1 through 5 of the Custom Regen Wizard, then click Finish. 

        

View Regen Settings  

1. Click Configure Regen  to open the Regen Resistor screen. 

 

Click View Settings to open the Regen Settings screen. 
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APPENDIX A 

I2T TIME LIMIT ALGORITHM 

 

Overview 

The I2T current limit algorithm continuously monitors the energy being delivered to the motor 

using the I2T Accumulator Variable. The value stored in the I2T Accumulator Variable is compared 

with the I2T setpoint that is calculated from the user-entered Peak Current Limit, I2T Time Limit, 

and Continuous Current Limit. Whenever the energy delivered to the motor exceeds the I2T 

setpoint, the algorithm protects the motor by limiting the output current or generates a fault.  

 

Formulas and Algorithm Operation 

 

Calculating the I2T Setpoint Value 

The I2T setpoint value has units of Amperes2-seconds (A2S) and is calculated from programmed 

motor data. The setpoint is calculated from the Peak Current Limit, the I2T Time Limit, and the 

Continuous Current Limit as follows: 

I2T setpoint =  

(Peak Current Limit2 – Continuous Current Limit2) * I2T Time Limit 

 

Algorithm Operation 

During amplifier operation, the I2T algorithm periodically updates the I2T Accumulator Variable 

at a rate related to the output current Sampling Frequency. The value of the I2T Accumulator 

Variable is incrementally increased for output currents greater than the Continuous Current Limit 

and is incrementally decreased for output currents less than the Continuous Current Limit. The 

I2T Accumulator Variable is not allowed to have a value less than zero and is initialized to zero 

upon reset or +24 Vdc logic supply power-cycle. 

 

Accumulator Increment Formula 

At each update, a new value for the I2T Accumulator Variable is calculated as follows: 

I2T Accumulator Variable n+1 =  

I2T Accumulator Variable n  

+(Actual Output Current n+1
2 – Continuous Current Limit2) * Update period 

 

After each sample, the updated value of the I2T Accumulator Variable is compared with the I2T 

setpoint. If the I2T Accumulator Variable value is greater than the I2T Setpoint value, then the 

amplifier limits the output current to the Continuous Current Limit. When current limiting is 

active, the output current will be equal to the Continuous Current Limit if the commanded current 

is greater than the Continuous Current Limit. If instead the commanded current is less than or 

equal to the Continuous Current Limit, the output current will be equal to the commanded 

current. 
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Application Example 

 

Operation of the I2T current limit algorithm is best understood through an example. For this 

example, a motor with the following characteristics is used: 

• Peak Current Limit – 12 A 

• I2T Time Limit – 1 S 

• Continuous Current Limit – 6 A 

 

From this information, the I2T setpoint is: 

setpoint = (12 A2–6 A2) * 1 S = 108 A2S 

 

Plot Diagrams 

The plots that follow show the response of an amplifier (configured w/ I2T setpoint = 108 A2S) 

to a given current command. For this example, DC output currents are shown in order to simplify 

the waveforms. The algorithm essentially calculates the RMS value of the output current, and 

thus operates the same way regardless of the output current frequency and wave shape. 

 

  
Diagram A 

 

At time 0, plot diagram A shows that the actual output current follows the commanded current. 

Note that the current is higher than the continuous current limit setting of 6 A. Under this 

condition, the I2T Accumulator Variable begins increasing from its initial value of zero. Initially, 

the output current linearly increases from 6 A up to 12 A over the course of 1.2 seconds. During 

this same period, the I2T Accumulator Variable increases in a non-linear fashion because of its 

dependence on the square of the current.  

 

At about 1.6 seconds, the I2T Accumulator Variable reaches a value equal to the I2T setpoint. At 

this time, the amplifier limits the output current to the continuous current limit even though the 

commanded current remains at 12 A. The I2T Accumulator Variable value remains constant 

during the next 2 seconds since the difference between the actual output current and the 

continuous current limit is zero.  
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At approximately 3.5 seconds, the commanded current falls below the continuous current limit 

and once again the output current follows the commanded current. Because the actual current 

is less than the continuous current, the I2T Accumulator Variable value begins to fall 

incrementally. 

The I2T Accumulator Variable value continues to fall until at approximately 5.0 seconds when 

the commanded current goes above the continuous current limit again. The actual output current 

follows the current command until the I2T Accumulator Variable value reaches the I2T setpoint 

and current limiting is invoked. 

 

  
Diagram B 

 

 

I2T Scope Trace Variables 

Two Scope Tool trace variables are available for monitoring whether the I2T accumulator is 

accumulating or discharging.  

• The I2T Amplifier Accumulator variable evaluates the accumulator against the factory set 

current limits of the amplifier. 

• The I2T Motor Accumulator variable evaluates the accumulator against the user-

programmed current loop values. 

The value shown Diagram B has been normalized so that 100% equals the I2T setpoint.  

When either trace variable line reaches 100%, current limiting will be invoked.  
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APPENDIX B 

HOMING METHODS 

 

Overview 
There are several homing methods. Each method establishes the: 

• Home reference (limit or home switch transition or encoder index pulse) 

• Direction of motion and, where appropriate, the relationship of the index pulse to limit or 

home switches. 

 

Homing Diagram Legend 
As highlighted in the example below, each homing method diagram shows the starting position 

on a mechanical stage. The arrow line indicates direction of motion, and the circled H indicates 

the home position. Solid line stems on the index pulse line indicate index pulse locations. Longer 

dashed lines overlay these stems as a visual aid. Finally, the relevant limit switch is represented, 

showing the active and inactive zones and transition. 

 
Note that in the homing method descriptions, negative motion is leftward and positive motion is 

rightward.  

Homing Method Descriptions 

Set current position as home 

The current position is the home position.  

Next Index 

Direction of Motion: Positive 

Home is the first index pulse found in the positive direction. Direction of motion is positive. If a 

positive limit switch is activated before the index pulse, an error is generated.  

Index Pulse

H

Positive Limit
Switch

H

Starting position

Axis

Sw itch inactive Sw itch active

Sw itch transition

Index pulse location

Direction of motion

Mechanical Stage Limits

Home position

Starting position
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Direction of Motion: Negative 

Home is the first index pulse found in negative direction. Direction of motion is negative. If a 

negative limit switch is activated before the index pulse, an error is generated.  

 

Limit Switch 

Direction of Motion: Positive  

Home is the transition of the positive limit switch. Initial direction of motion is positive if the 

positive limit switch is inactive.  

 

Direction of Motion: Negative 

Home is the transition of negative limit switch. Initial direction of motion is negative if the 

negative limit switch is inactive.  

 

Index Pulse

H

Index Pulse

H

H

Positive Limit
Switch

H

Negative Limit
Switch
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Limit Switch Out to Index 

Direction of Motion: Positive  

Home is the first index pulse to the negative side of the positive limit switch transition. Initial 

direction of motion is positive if the positive limit switch is inactive (shown here as low).  

 

Direction of Motion: Negative 

Home is the first index pulse to the positive side of the negative limit switch transition. Initial 

direction of motion is negative if the negative limit switch is inactive (shown here as low).  

 

Hardstop 

Direction of Motion: Positive 

Home is the positive hard stop. Direction of motion is positive. In servo modes, the hard stop is 

reached when the amplifier outputs the homing Current Limit continuously for the amount of 

time specified in the Delay Time.  

If a positive limit switch is activated before the hard stop, an error is generated.  

 

Direction of Motion: Negative 

Home is the negative hard stop. Direction of motion is negative. The hard stop is reached when 

the amplifier outputs the homing Current Limit continuously for the amount of time specified in 

the Delay Time. If a negative limit switch is activated before the hard stop, an error is generated. 
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Hardstop Methods in Stepper Mode 

In Stepnet amplifiers operating in stepper mode with an encoder, the hard stop is reached when 

the following error is exceeded. When using hardstop methods in stepper mode, do not disable 

following error.  

 

Hardstop Out to Index 

Direction of Motion: Positive 

Home is the first index pulse on the negative side of the positive hard stop. Initial direction of 

motion is positive. The hard stop is reached when the amplifier outputs the homing Current Limit 

continuously for the amount of time specified in the Delay Time. If a positive limit switch is 

activated before the hard stop, an error is generated. 

 

Direction of Motion: Negative 

Home is the first index pulse on the positive side of the negative hard stop. Initial direction of 

motion is negative. The hard stop is reached when the amplifier outputs the homing Current 

Limit continuously for the amount of time specified in the Delay Time. If a negative limit switch 

is activated before the hard stop, an error is generated. 

 

Hardstop Out to Index Methods in Stepper Mode 

In Stepnet amplifiers operating in stepper mode with an encoder, the hard stop is reached when 

the following error is exceeded. When using hardstop methods in stepper mode, do not disable 

following error. 

 

Home Switch 

Direction of Motion: Positive 

Home is the home switch transition. Initial direction of motion is positive if the home switch is 

inactive. If a limit switch is activated before the home switch transition, an error is generated. 
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Direction of Motion: Negative 

Home is the home switch transition. Initial direction of motion is negative if the home switch is 

inactive. If a limit switch is activated before the home switch transition, an error is generated. 

 
 

Home Switch Out to Index 

Direction of Motion: Positive 

Home is the first index pulse to the negative side of the home switch transition. Initial direction 

of motion is positive if the home switch is inactive. If a limit switch is activated before the home 

switch transition, an error is generated. 

 

Direction of Motion: Negative 

Home is the first index pulse to the positive side of the home switch transition.  

Initial direction of motion is negative if the home switch is inactive. If a limit switch is activated 

before the home switch transition, an error is generated. 
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Home Switch In to Index 

Direction of Motion: Positive 

Home is the first index pulse to the positive side of the home switch transition. Initial direction 

of motion is positive if the home switch is inactive. If a limit switch is activated before the home 

switch transition, an error is generated. 

 

Direction of Motion: Negative 

Home is the first index pulse to the negative side of the home switch transition. Initial direction 

of motion is negative if the home switch is inactive. If a limit switch is activated before the home 

switch transition, an error is generated. 

 

Lower Home 

Direction of Motion: Positive 

Home is the negative edge of a momentary home switch. Initial direction of motion is positive if 

the home switch is inactive. Motion will reverse if a positive limit switch is activated before the 

home switch; then, if a negative limit switch is activated before the home switch, an error is 

generated.  
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Direction of Motion: Negative 

Home is the negative edge of a momentary home switch. Initial direction of motion is negative. 

If the initial motion leads away from the home switch, the axis reverses on encountering the 

negative limit switch; then, if a positive limit switch is activated before the home switch, an error 

is generated.  

 

Upper Home 

Direction of Motion: Positive 

Home is the positive edge of a momentary home switch. Initial direction of motion is positive. If 

the initial motion leads away from the home switch, the axis reverses on encountering the 

positive limit switch; then, if a negative limit switch is activated before the home switch, an error 

is generated. 

 

Direction of Motion: Negative 

Home is the positive edge of momentary home switch. Initial direction of motion is negative if 

the home switch is inactive. If the initial motion leads away from the home switch, the axis 

reverses on encountering the negative limit switch; then, if a positive limit switch is activated 

before the home switch, an error is generated. 
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Lower Home Outside Index 

Direction of Motion: Positive 

Home is the first index pulse on the negative side of the negative edge of a momentary home 

switch. Initial direction of motion is positive if the home switch is inactive. If the initial motion 

leads away from the home switch, the axis reverses on encountering the positive limit switch; 

then, if a negative limit switch is activated before the home switch, an error is generated.  

 

Direction of Motion: Negative 

Home is the first index pulse on the negative side of the negative edge of a momentary home 

switch. Initial direction of motion is negative. If the initial motion leads away from the home 

switch, the axis reverses on encountering the negative limit switch; then, if a negative limit 

switch is activated before the home switch, an error is generated.  
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Lower Home Inside Index 

Direction of Motion: Positive 

Home is the first index pulse on the positive side of the negative edge of a momentary home 

switch. Initial direction of motion is positive if the home switch is inactive. If the initial motion 

leads away from the home switch, the axis reverses on encountering the positive limit switch; 

then, if a negative limit switch is activated before the home switch, an error is generated. 

 

Direction of Motion: Negative 

Home is the first index pulse on the positive side of the negative edge of a momentary home 

switch. Initial direction of motion is negative. If the initial motion leads away from the home 

switch, the axis reverses on encountering the negative limit switch; then, if a negative limit 

switch is activated before the home switch, an error is generated.  
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Upper Home Outside Index 

Direction of Motion: Positive 

Home is the first index pulse on the positive side of the positive edge of a momentary home 

switch. Initial direction of motion is positive. If the initial motion leads away from the home 

switch, the axis reverses on encountering the positive limit switch; then, if a negative limit switch 

is activated before the home switch, an error is generated. 

 

Direction of Motion: Negative 

Home is the first index pulse on the positive side of the positive edge of a momentary home 

switch. Initial direction of motion is negative if the home switch is inactive. If the initial position 

is right of the home position, the axis reverses on encountering the home switch. 
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Upper Home Inside Index 

Direction of Motion: Positive 

Home is the first index pulse on the negative side of the positive edge of momentary home 

switch. Initial direction of motion is positive. If initial motion leads away from the home switch, 

the axis reverses on encountering the positive limit switch; then, if a negative limit switch is 

activated before the home switch, an error is generated.  

 

Direction of Motion: Negative 

Home is the first index pulse on the negative side of the positive edge of a momentary home 

switch. Initial direction of motion is negative if the home switch is inactive. If initial motion leads 

away from the home switch, the axis reverses on encountering the negative limit; then, if a 

negative limit switch is activated before the home switch, an error is generated. 
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APPENDIX C 

ASCII COMMANDS/SERIAL CONTROL 

Copley ASCII Interface 
An amplifier’s RS-232 serial bus can be used by an external control application (HMI, 

PLC, PC, etc.) for setup and direct serial control of the amplifier. The control application 

can issue amplifier commands from the set of ASCII format commands that make up 

the Copley Controls ASCII Interface.  

For more information, see the Copley ASCII Interface Programmer’s Guide.  

 

CME 2 ASCII Command Line Interface Tool 
As described below, the CME ASCII Command Line Interface tool provides a simple way 

to enter Copley ASCII commands. 

 

 Use the ASCII Command Line Interface to Enter 
Commands 

1. From the Main screen, choose Tools→ASCII Command Line to open the tool. 

 

2. Enter an ASCII Command in the Command field.  

3. Press the Enter key to send the command to the amplifier. Observe the Response field. 

If a value is returned, it is preceded by the letter “v.” In the following example, the get 

command was used to retrieve the amplifier RAM value of variable 0x32 (actual position). 
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An error code would be preceded by the letter “e.”  

TIP: To view an error definition, hold the mouse pointer over the error number.       

For more information, see the Copley ASCII Interface Programmer’s Guide and the 

Copley Amplifier Parameter Dictionary. 

 

Single-Axis Serial Connection 
For RS-232 serial bus control of a single axis, set the CAN node address of that axis to 

zero (0). Note that if the CAN node address is switched to zero after power-up, the 

amplifier must be reset or power cycled to make the new address setting take effect. 

 

Multi-Drop Serial Connection 
A serially connected amplifier can be used as a multi-drop gateway for access to other 

amplifiers linked in a series of CAN bus connections. Set the CAN node address of the 

serially connected amplifier (gateway) to zero (0). Assign each additional amplifier in 

the chain a unique CAN node address value between 1 and 127. For more information 

on CAN node address assignment, see Network Configuration. Use 120 Ohms 

termination on the first and last amplifier. 
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APPENDIX D 

COPLEY USB TO RJ11 

Recommended Device 
 

Copley Controls recommends using the 232USB9M USB to Serial Adapter made by B&B 

Electronics (http://www.bb-elec.com/).  Copley Controls has tested this low-cost device 

extensively with CME software. 

 

Factory Settings 
 

The factory settings for this device works well, but Copley recommends changing the Latency 

time for faster performance with CME software.  This value is changed through the Windows 

Device Manager 

 

1 Open the Device Manager dialog from the Windows Control Panel and expand the Ports 

(COM &LPT) node: 

 

 
 

2 Select the COM port that is used by the USB to Serial Adapter (refer to manufacturer’s 

documentation for details). 

 

3 Right-click that port and select Properties from the pop-up menu.  This will open the 

device properties. 

 

http://www.bb-elec.com/
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4 Select the Port Settings tab, then click the Advanced button. 
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5 The factory default setting for Latency Timer is 16 ms as shown above.  Change the 

Latency Timer to 1 ms, No other settings should be changed.  Click OK to set the new 

value and close the dialog. 

 

6 Click OK to close the device properties dialog. 
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